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INTRODUCTION 

This is an "ideas" book. Rather than focusing on the commands that you 
use with the Macintosh, the emphasis is on using the Macintosh to accom­
plish a specific goal. You will see how to use some subtle techniques and 
how to combine commands in order to achieve a desired result. 

In this book, you will discover ideas for using two applications programs, 
MacPaint and MacWrite. You will see methods of combining the diverse 
capabilities of each, resulting in solutions far superior to what might be 
possible separately. 

While this book emphasizes solutions, it is not expected that you, the 
reader, are an expert Macintosh user. In fact, the features and commands of 
MacWrite, MacPaint, and the Macintosh itself are clearly explained in the 
context of particular applications. By seeing how a command can be used as 
well as what it does, you should get a more intuitive feel for using the 
Macintosh. 

This book is divided into five parts. Parts I through IV introduce the 
main topics of the book: the Macintosh system, the MacWrite word proces­
sor, the MacPaint graphics processor, and combining MacWrite and 
MacPaint. 

These first four parts each contain two chapters. The first chapter of the 
section discusses the capabilities and features of the topic item. The second 
chapter of the section presents an application that demonstrates the use of 
the topic i tern. 
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Part V is entirely devoted to applications using MacWrite and MacPaint. 
Altogether there are a total of nine applications-oriented chapters in the 
book: 

Chapter 2, Customizing Your Desktop, examines the Macintosh desk 
accessories. This chapter reviews the different accessories and demonstrates 
how some of them can be used to customize your Macintosh. 

Chapter 4, Report Writing With MacWrite, discusses techniques and 
tips for writing reports using MacWrite. These techniques are applicable 
for school and business reports as well as other forms of writing, such as 
memos, business letters, manuals, or even books. 

Chapter 6, Patchwork Patterns, demonstrates the power of MacPaint to 
create geometric patterns in just a few minutes. 

Chapter 8, Creating a Letterhead, demonstrates the capability of the 
Macintosh to integrate programs like MacWrite and MacPaint. You see 
how MacPaint can be used to create custom letterheads for later use with 
Mac Write. 

Chapter 9, Working With Text in MacPaint, explores the text manipula­
tion capabilities of MacPaint. The differences between handling text in 
MacPaint versus text in MacWrite are examined. 

Chapter 10, Scientific and Mathematical Formulas, discusses methods 
for creating formulas with both MacWrite and MacPaint. You see how 
Mac Write can be used to design formulas and then look at the "picture­
perfect" formulas that can be created using MacPaint. 

Chapter 11, Text Highlighting and Emphasis, examines different meth­
ods you can use to create visually exciting reports. This chapter looks at 
creating special chapter headings and then demonstrates some very effec­
tive ways of highlighting special parts of your reports. 

Chapter 12, Short Takes, is an assortment of special techniques using 
different tools in MacPaint. 

Chapter 13, Printing With the Macintosh, looks at the printing capabili­
ties of the Macintosh. 

If possible, read this book while sitting at the keyboard of a Macintosh. 
Do not feel that you have to read the book from front to back. Find an 
application that looks interesting to you. Then sit down and try it out. 

vii 



If you find a command or operation you do not understand, use the index 
to locate the section where the command is discussed in greater detail. Then 
experiment. Play. If an alternate use of a given technique pops into mind, 
take a minute to explore. 

Hopefully, the ideas and applications in this book will stimulate your 
imagination. As you see various techniques demonstrated, you may think of 
ways to apply them to your own applications. 

viii 



P A R T 0 N E 

The Apple Macintosh represents the first 
major player in the third generation of personal 

computers. The first generation shattered the 
traditional concept of a computer as being very big, 
very expensive, and available only to medium- and 

large-sized companies with their own data 
processing departments. These early microcomputers, 

perhaps best exemplified by the Apple II 
system, were inexpensive but were also 

limited in both processing power and memory 
capacity. However, the average user of this machine was 

a pioneering type who would put up with these limitations. 



The second generation of the personal computer was really just a 
small step up from the first. This generation centered around a single 
computer, the IBM Personal Computer, or PC. The PC provided more 
processing power and the ability to support much more memory than 
the typical first-generation personal computer. With increases in 
memory capacity, much more complex software was developed for the 
PC. But the biggest breakthrough was the acceptance of the PC by the 
business community. While the Apple II and its peers were considered 
by many to be not much more than toys or hobbyist computers, the 
idea that IBM was making a personal computer legitimized the whole 
microcomputer industry. 

Despite their differences, both the first- and second-generation micro­
computer systems had much in common. In order to set up a working 
system, you had to pick and choose from a vast array of hardware and 
software components that often did not work well together (or some­
times did not even work at all). Furthermore, much of the software 
was extremely difficult to learn, a problem compounded by a lack of 
consistency in the way different programs operated. 

The Apple Macintosh represents an exciting departure from the 
first two generations of personal computers. The Macintosh is a com­
plete system that can be put to use very quickly. It provides a consis­
tent way for you to work with applications programs. 

The following two chapters introduce you to the Macintosh, the 
general Macintosh system, and many of the basic concepts involved in 
using it. As you proceed through those chapters, you will discover 
how to accomplish a number of useful tasks and operations. 



C H A P T E R 0 N E 

INTRODUCING 
THE PLAYERS 

This chapter discusses the basic Macintosh system. You will take a look at 
the desktop, the Finder program, and the commands in the Finder's pull­
down menus. 

THE MACINTOSH SYSTEM 

The basic Macintosh system consists of the five parts shown in Figure 1-1: 
the display screen, which shows you what the Macintosh or an applications 
program is currently doing; the printer, which provides a printed copy of 
the Macintosh display or the results of an applications program; the disk 
drive, which stores applications programs and other types of files; the key­
board, with which you type in text or numbers; and the mouse, with which 
you enter commands. 

Perhaps the best news about the Macintosh is that you really do not need 
to know much about the hardware. Unlike the user of a first- or second­
generation personal computer, you will not need to be aware of the internal 
makeup of your Macintosh in order to use it. Just as you do not have to be a 
mechanic to drive a car, you do not have to be a hardware expert to operate 
the Macintosh. 

3 
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Display Screen 

Printer Disk Drive 

Keyboard 

Mouse 

Figure 1-1. A basic Macintosh system 
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THE DESKTOP 

The manner in which you interact with the Macintosh (often called the 
"user interface" in computer parlance) is analogous to working at an office 
desk. On the Macintosh desktop you move documents around, set up files 
containing groups of documents, and perform a host of other functions like 
those performed in a traditional office. It is this familiar environment that 
makes learning to use the Macintosh so easy. 

The Macintosh desktop is depicted on the display screen. As a user, you 
are linked to this desktop by the Macintosh mouse. The mouse is repre­
sented by a cursor, or pointer, on the screen. As you move the mouse around 
on your desk, the cursor parallels its movement on the screen. The shape of 
the cursor will change to reflect the type of selection or command that you 
can request at the current position on the screen. 

The mouse has a button on it. There are three basic ways to use the 
mouse: 

• clicking- pressing the button and immediately releasing it. 

• dragging- pointing to an object, holding down the button, and mov­
ing the mouse. 

• double-clicking-quickly clicking the button twice. 

How the Macintosh responds depends on the applications program cur­
rently being used and where the cursor is on the screen. You will see exam­
ples of how the mouse is used later in this chapter. 

Regardless of the applications program, commands and operations are 
presented by icons and pull-down menus. An icon is simply a picture that 
represents a specific Macintosh object. For example, a picture of a document 
represents an actual document you created. The use of icons for entering 
commands helps remind you of what the commands actually do. 

A pull-down menu contains a list of commands organized in groups 
according to the type of functions they perform (just as a restaurant menu is 
divided into different categories, such as dinners, appetizers, and drinks). An 
applications program may have several command menus. 

The name of each menu is listed along the top of the screen. You can 
"pull down" a menu simply by pointing the cursor to the menu name and 
holding down the mouse button. To execute a particular command within a 
menu, pull down the menu list, drag the cursor down to point to the 
appropriate command, and then release the mouse button to execute the 
command. 
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THE FINDER 

When you first power up the Macintosh, or when you are not running an 
applications program, you can use the Finder. The Finder is a built-in pro­
gram that simulates an office desktop. On the display of the Macintosh the 
Finder depicts an empty desktop, as shown in Figure l-2. 

The Finder gives you the ability to: 

• Start up applications programs like MacWrite and MacPaint. 

• Examine and manipulate the files on a disk. You can throw away 
unneeded files, make copies of needed files, and organize your disks by 
moving files into folders. 

A Macintosh folder is like a file folder except that it is stored on a disk. 
You store all kinds of memos, reports, or any other documents in file 
folders, organizing your work by grouping together the records of a 
certain client or contract. Within a Macintosh folder you can place 
applications programs, data files, and even other folders. By logically 
grouping them together in this way, you can avoid being overwhelmed 
by a large number of files on a disk. 

You can give each folder a name that reminds you of what is stored 
inside. You "open" a folder to look at its contents and "close" the folder 
when you are through. 

• Initialize and erase disks, that is, prepare completely blank disks for 
storing Macintosh files, applications, and folders. 

• Copy files, folders, and applications from one disk to another. 

• Eject a disk. 

• Print documents or graphics created by applications programs. 

WINDOWS 

The Finder displays the contents of disks and folders in directory windows. 
A directory is a list of the files, applications programs, and folders stored on 
a given disk. The directory window displays this list for you. 

To see what a directory window looks like, move the mouse so that the 
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Figure 1-2. The Macintosh desktop 
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Disk leon 

cursor points to the icon representing the disk in the upper-right corner. 
Now press the mouse button twice (double-click). This should "open" the 
directory window for the disk. The screen may appear as shown. 
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,. * Fi le Edit Uiew Special 

Moc'vlrlte- MocPoint 

LJLJ 
System Folder Empty Folder 

This is typical of the windows you will see with many Macintosh pro­
grams. The parts of a directory window are shown in Figure 1-3. 

The functions of these parts a re as follows: 

Close Box "Closes" the window if you point the cursor at this small 
square and click the mouse button. This is identical to the Close com­
mand (see " File Menu ," later in the chapter). 

Title Bar Displays the name given to the window. You can move the 
window about the screen by pointing the cursor a t the title bar, pressing 
and holding down the mouse button, and then dragging the window 
about the screen. 

Info Bar Tells you specifi c information about the items in the window. 
Includes a count of the number of items, the amount of disk space they 
take up, and the total amount of free space on the disk. 

Folder Icon Represents a folder that may contain applications programs, 
system files, documents, or even other folders. You can make new empty 
folders by selecting the Empty Fo lder icon and duplicating it. (See the 
Duplicate command in "File Menu.") 
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System Disk 
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Figure 1-J. Th e parts of a directory window 

Scroll Bar Used if the directory is larger than the window itself. In other 
words, if the window is not big enough to display an entire directory at 
once, you can use the scroll bar to scroll the directory in order to locate an 
item of imerest. 

Notice that there are two scroll ba rs , one for scrolling vertically, another 
for scrolling horizonta lly. A blank scroll bar indicates that all of the 
information in that direction is visible in the window. 

If the scrol l ba r is shaded, you will no tice a small square on the bar. The 
position of the square indicates the current relative position of the win­
dow with respect to the entire directory. If the square is a t the top of the 
scroll bar, you are viewing the top part of the directory. If the square is at 
the bottom, you can see the bottommost portion of the directory. 
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To scroll the directory past the window in small increments, use the two 
arrows at each end of the scroll bar. Point the cursor at the appropriate 
arrow and click the mouse button to move in the selected direction. To 
scroll smoothly through the directory, hold down the mouse button as 
you point to the appropriate arrow. 

You can quickly move to any position in the directory window by pointing 
the cursor at the square on the scroll bar, holding down the mouse button, 
and dragging the square to the desired position. When you release the 
mouse button, the window will display the selected portion of the 
directory. 

Size Marker Allows you to change the size and shape of the window. 
Point the cursor at the size marker and hold down the mouse button. As 
you drag the cursor around the screen, you will see a dotted rectangle. 
Drag the rectangle to the size that you need and release the mouse button. 

You will see windows with features like the scroll bar and size marker in 
MacWrite and other applications programs. Other elements, such as the title 
bar and the close box, will appear in most applications on the Macintosh. It 
is well worth the time to experiment and familiarize yourself with these 
features now. 

Note that any number of windows can be open on the screen at a given 
time. Windows may partially overlap one another, or one window may 
completely cover another. However, only one window can be "active" at a 
time. 

The active window will always be completely displayed on the screen. 
Only the active window will have a title bar containing the window title, 
line pattern, and close box. All inactive windows will have a blank title bar. 

If you want to make a window active, simply point the cursor at the win­
dow you want and click the mouse button. If you cannot see the window 
that you want to activate but you know it is open (in other words, it is 
buried behind other windows), you will either have to close or move some of 
the windows that are covering it up. 

THE FINDER MENU BAR 

The menu bar is at the top of the Finder screen. There are five menus in the 
menu bar ~hown in Figure 1-2. The image of the apple in the far left corner 
contains a menu for selecting the Macintosh desk accessories. Discussion of 
these accessories will be deferred until Chapter 2. 
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The remaining four menus conta in commands that you can use with the 
Finder. Yo u may recall that you pull down a menu to see what commands 
are avai lable by pointing the cursor a t the menu name and then holding 
down the mouse button to display the menu contents. A command within 
the menu is selected and executed by dragging the cursor down the menu list 
until it points to the desired command and releasing the mouse button. In 
the following example the File menu is pulled down and the Open com­
mand is selected: 

Now let 's take a look at each of the menus and see what commands they 
include. 

File Menu 

The commands within the File menu a llow you to perform operations on 
entire files. Using these commands you can do things like open, close, 
duplicate, and print files. You can a lso o btain additiona l informatio n about 
a file or eject a disk from a disk drive. 
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Open Opens a selected icon. To select an icon, poim the cursor at it and 
press the mouse button. T he icon will be highlighted to indicate that it 
was selected. 

Different icons react differen tly when open. Disk and fo lder icons merely 
open to show what files they con tain. Opening an application icon, 
though, tells the finder to execute that application. If the icon represents a 
document that you created with some application, the finder executes the 
appropriate application using the documem you selected. 

Duplicate Makes a copy of the selected icon. If you have selected a folder, 
the folder and all of i ts coments are duplicated. 

Get Info Opens a specia l window that shows you information about the 
item represented by the selected icon. You can use Get Info to obtain the 
size and type of an item, the date and time when an item was created, 
where an item is stored, and when it was last modified. In certain cases, an 
optional description of the item 's function may appear. Let's use Get Info 
on the System Disk: 

r • File Edit Uiew Special 

Kind: 
Size: 
Where: 
Created: 
Modified: 

0 !.o<kt~ll 

System Disk 

disk 
29696 bytes auailable, 370688 bytes used 
internal driue 
Friday, January 20, 1984 at II :37 AM 
Friday, February 17, 1984 at 1:35PM 

., 

Put Back Undoes any recent movemem s of files and folders. For exam­
ple, if you move a file from one folder to ano ther, you can use Pu t Back to 
return the selected file to its original location. 
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Close The opposite of the Open command; closes the active window. 

Close All Closes all opened windows. 

Print Prints the contents of one or more selected documents on the prin­
ter. The applications program used to create the document will be run to 
perform the actual printing. 

Eject Ejects the selected disk from the proper disk drive. 

Edit Menu 

The commands within this menu let you do a limited amount of text edit­
ing with the Finder. You can use these commands to give names to new 
folders, files, and disks (or to rename them). You can also use these com­
mands with the desk accessories discussed in the next chapter. 

You can replace the name of an icon simply by selecting that icon and 
typing in the new name. If you want to edit a portion of the name (to correct 
a typing error, for example), you can point the cursor to the position where 
you want to make the change and click the mouse button. This will set the 
insertion point, shown on the screen as a small vertical bar. You can now 
insert the new text or use the BACKSPACE key to delete characters. 

Several of the commands in the Edit menu require you to select the text to 
be changed. One way to do this is to point the cursor at the start of the 
selected text and hold down the mouse button as you drag the mouse over 
the selected area. The affected text will be highlighted. This procedure will 
be covered in more detail in Chapter 3. 

Undo Cancels the effects of the last text-editing operation. 

Cut Removes the selected text and places it on the system Clipboard. 
The Clipboard is used to store portions of text and graphic images tem­
porarily. The Cut, Copy, and Paste commands discussed here are used to 
move text and graphics on and off of the Clipboard. (Ff)>r more informa­
tion about the Clipboard, see "Desk Accessories" in Chapter 2.) 

Copy Makes a copy of the selected text and places it on the Clipboard. 

Paste Makes a copy of the current contents of the Clipboard and places it 
at the text insertion point. 
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Clear Deletes the selected text without doing anything to the system 
Clipboard. 

Select All Selects every icon in the currently active window. 

Show Clipboard Opens the system Clipboard window and shows the 
current contents. 

View Menu 

Commands in the View menu change the way that the directory is displayed. 
The icon display uses a picture to represent each entry in the directory. The 
other types of displays use written methods to organize the names and func­
tions of directory entries and other information. 

By Icon Shows entries as pictures. 

By Name Organizes the directory in alphabetical order by the names of 
the entries. 

By Date Organizes a directory according to the dates that the entries were 
changed, from newest to oldest. 

By Size Arranges a directory according to the size of the entries, from 
largest to smallest. 

By Kind Arranges the directory according to the function of each entry. 

Special Menu 

The commands in the Special menu help you manage or organize your 
disks. With these commands you can reorganize a directory window, free up 
space on your disk, or erase the entire contents of a disk. 

Clean Up Reorganizes or straightens up the currently selected directory 
window. This works only when the directory is displayed by icon. 

Empty Trash You can dispose of any item on a disk by pointing the 
cursor at its icon, pressing and holding down the mouse button, and 
dragging the icon to the trash can at the lower right of the screen. This 
does not actually free up the space occupied by that item, however; that is 
done with the Empty Trash command. 
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Erase Disk Lets you erase all the contents of a selected disk. Take care not 
to do this until you are sure you do not need any of the files on that disk. 

Set Startup Allows you to select an application program that you want to 
automatically begin running whenever you start the Macintosh with the 
current disk. For example, if you have a system disk with Mac\\1-ite on it, 
you can select the MacWrite icon and then choose Set Startup. This will 
cause MacWrite to automatically begin when you turn on the Macintosh 
and insert this disk. 

SHORTCUTS 

A select group of operations can be executed using shortcuts. These short­
cuts are just quick ways of performing the same operations. The following 
shortcuts are available when you are using the Finder: 

Double-Click If you point the cursor at an icon on the. screen and 
quickly click the mouse button twice, you get the same result as if you 
selected that icon, pulled down the File menu, and selected the Open 
command. For example, double-clicking on a folder icon will open the 
folder and show you the files contained within. Double-clicking on an 
application icon starts up the application. 

If you double-dick the mouse button while pointing to a word of text, the 
entire word will be selected. 

Shift-Click If you hold down the SHIFT key while you click the mouse 
button, the icon being pointed at will be added to any other previous 
selections. For example, you can shift-dick to select and then move more 
than one file at a time into a newly created folder. 

Close Box Clicking the mouse button with the cursor pointing at the 
close box has the same effect as selecting a window and then selecting the 
Close command from the File menu. 

RETURN Key and ENTER Key Used to select the highlighted response to a 
dialog box (a window displaying the Macintosh's messages). 

TAB Key Used in dialog boxes having more than a single place for enter­
ing typed information. Pressing the TAB key within a dialog box moves 
the insertion point to the next place where information can be entered. 
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!!:] (£] FILE-~UPLICATE 
[![][) FILE-GET INFO 

!!:] (I] FILE -EJECT 

LJ[I) E~IT-UN~O 
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L](2] EDIT-PASTE 

[!:]II] EDIT -SELECT ALL 

Figure 1-4. COMMAND key shortcuts 

BACKSPACE Key If you have selected a block of text (more than one char­
acter), pressing the BACKSPACE key will delete the entire block. If you 
instead type something at the keyboard, the text you type will replace the 
selected block of text. 

COMMAND Key There are a number of shortcuts that use the COMMAND 

key in conjunction with some other key to issue a command. The COM­

MAND key shortcuts shown in Figure 1-4 are valid in the Finder. 
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CUSTOMIZING 
YOUR DESKTOP 

With the Macintosh, all work is centered around the concept of the desktop. 
Using the Finder, you can straighten up the desktop, create file folders to 
organize your work, make copies of documents, and do other office-like 
tasks. The Macintosh carries this desktop analogy one step further by offer­
ing a number of desk accessories for your use. 

This chapter describes the desk accessories and demonstrates their uses. As 
you will see, they form the backbone of all of the Macintosh applications 
programs. 

DESK ACCESSORIES 

Move the mouse around so that the cursor points to the apple icon in the 
upper-left corner of your Macintosh screen. Press and hold down the mouse 
button. You should see a pull-down menu appear. This is the desk accessory 
menu. Within this menu is a list of the seven desk accessories; these are the 
Scrapbook, Alarm Clock, Note Pad, Calculator, Key Caps, Control Panel, 
and Puzzle. 

The desk accessory menu works just like any other pull-down menu. Pull 
down the menu and drag the cursor down the list of accessories. When you 

17 
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are pointing to the desk accessory of your choice, release the mouse button to 
"open" it for use. Each accessory displays a special window when it is 
opened. The windows allow you to use the accessories. 

What is unique about the desk accessory menu is that it is automatically 
available regardless of the applications program you are using. This means 
that every accessory is always within immediate reach on the Macintosh. 

The Scrapbook 

Perhaps the most powerful and useful of all of the accessories is the Scrap­
book. Simply put, the Scrapbook provides a long-term storage facility for 
objects placed on the system Clipboard. 

The Clipboard is a temporary storage area in which the Finder and other 
applications like MacWrite and MacPaint can save text or graphics objects 
(pictures you create with MacPaint). Using the Cut, Copy, and Paste com­
mands (discussed in Chapter 1) with the Clipboard, you can move large 
sections of text around in a word processor, transport graphics images 
around in a graphics processor like MacPaint, or move other types of objects 
in different applications. The Clipboard can even be used to move objects 
from one application to another- for example, to move a graphics object 
from MacPaint into a document created by MacWrite. 

The Scrapbook is a set of pages, each page containing one item from the 
Clipboard. As already mentioned, the Scrapbook can be used as a long-term 
storage area for objects stored on the Clipboard. You use the same Cut, 
Copy, and Paste commands from the Edit menu to move items between the 
Scrapbook and the Clipboard. 

The Scrapbook window (shown in Figure 2-1) is a standard window with 
a scroll bar that lets you scroll through the pages of the Scrapbook. You 
cannot edit any part of a Scrapbook window. All you can do is move the 
contents of a page from the Scrapbook to the Clipboard and vice versa. 

If you use the Cut command with the Scrapbook, the current page will be 
deleted from the Scrapbook after it is copied to the Clipboard. The Copy 
command simply places a copy of the Scrapbook page onto the Clipboard 
without affecting the Scrapbook in any way. 

When you Paste something from the Clipboard into the Scrapbook, the 
Macintosh automatically creates a new Scrapbook page and places a copy of 
the Clipboard into this new page. 

The Clipboard and the Scrapbook are so important to the structure of the 
Macintosh that Chapter 7 is devoted to discussing their use in depth. 
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This window gives you the current time of day. The Macintosh contains a 
built-in clock so that it can keep track of the current date and time of day. 

Notice the switch icon on the right side of the clock window. If you point 
the cursor there and click the mouse button, the clock window will open up 
to look like this: 

D 12:48:18 PM r 
2/18/84 

~@ II .. ~=~.· 
... ~ .. '" 

Cl:oc~ 

'Won ' Da.te 
'leon 

(SelectEd) 

Alaf'm 
'leon 

The middle section of the window displays the current date. If you point 
the cursor at either the month, day, or year and click the mouse button, you 
can change the corresponding part of the date by typing in a new value. 
This new date will be used as the current date. 

The bottom part of the clock window contains the clock, date, and alarm 
icons. When you first open the clock window, the date icon is selected, and 
the middle part of the window displays the current date. 

If you point the cursor to the clock icon and click the mouse button, you 
will see the current time in both the first and second lines of the clock win­
dow. Point the cursor to the hour, minute, second, or the A.M./P.M. part of 
the time on the second line and click the mouse button to select the part of 
the time to be changed. Up and down arrows will appear to the right of the 
table. Now, you can either type in the new value or click on the two arrows 
to set the current time of day. 

Selecting the alarm icon gives you access to the alarm clock feature of the 
Macintosh. The Clock window is shown in the following illustration. 
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To set the alarm, select the hour, minute, second, A.M., or P.M. and type in 
the appropriate value or dick on the up/down arrows. Turn on the alarm 
switch by pointing to the switch and pressing the mouse button (the switch 
is on when it is up). Once an alarm time is set and the switch is on, you can 
close the Alarm Clock window and go about your business. When it is time 
to sound the alarm, the Macintosh beeps once and starts blinking the apple 
icon to alert you. 

One suggestion: If you set the Alarm Clock accessory for some specific 
purpose, use the Note Pad (discussed in the next section) to jot down the 
reason. This way you will not forget the purpose of the alarm. 

If the Macintosh is of£ when it comes time to sound the alarm, the next 
time you turn the power on, the alarm will sound as soon as the Finder 
program starts up. 

You can use the Copy command (found in the Edit menu) to move the 
current time of day and date from the Alarm Clock window onto the system 
Clipboard. You can then move this information from the Clipboard into 
another application to date your work. 

The Note Pad 

The Note Pad accessory gives you a place to store eight pages of ideas, 
thoughts, or any other kinds of notes you want to keep. The parts of the 
Note Pad are shown in Figure 2-2. 

Figure 2-2 also explains how to use the Note Pad. You can type in text 
from the keyboard onto the current Note Pad page, or you can use the Clip­
board (with the Cut, Copy, and Paste commands) to move text in and out of 
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Figure 2-2. T he Note Pad 

the Note Pad. However, you cannot move graphics objects from the Cl ip­
board onto the Note Pad. The contents of the Note Pad are saved on the 
system disk when you turn off the Macintosh. 

The Calculator 

T he Calcula tor accessory is a simple fo ur-function calculator. When you 
select the Calculator fro m the desk accessory menu, you will see a fami liar 
image. 
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Use the Calculator as you would a normal calculator. You can either use 
the mouse to click the appropriate calculator key or type the entry on the 
keyboard. You will see the results on the display at the top of the calculator. 
Use the Copy command in the Edit menu to move the results of a series of 
calculations onto the Clipboard. Then, using the Paste command, you can 
transfer the results to another application. 

The Key Caps 

Key Caps is a handy, instant reference of the characters that can be entered 
from the Macintosh keyboard. When you first open the Key Caps window, 
you will see this display: 
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If you press the SHIFT key, you will see the characters that can be typed 
with the SHIFT key pressed: 

If you press the OPTION key, you will see the set o f characters that can be 
entered with the OPTION key pressed: 

' Finally, the SHIFT and OPTION keys can be used together to provide one 
more set of characters: 
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NOTE: The characters generated with the SHIFT-OPTION keys are not 
available with every character font. See Appendix A for a list of fonts 
(character styles) and the characters available with each . 

You can type text onto the display at the top part of the Key Caps window 
by typing on the keyboard. You can then use the Copy command in the Edit 
menu to place that text onto the system Clipboard. When you return to your 
application or to the Finder, you can use the Paste command to add Clip­
board contents wherever you want. 

The Control Panel 

The Apple Macintosh has only two external controls, the On/ Off switch 
and the brightness control knob for the display. However, through the Con­
trol Panel you can control a variety of different hardware settings. The Con­
trol Panel is shown in Figure 2-3. 
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Figure 2-J. The Control Panel 
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If you change the settings for any of the controls on the panel, the Macin­
tosh will "remember" the changes even when you turn the power off. The 
functions of the panel's controls are as follows: 

Speaker Volume Sets speaker volume. Slide the "volume control" to 7 
for the loudest setting and 0 to turn the speaker off. To slide the knob, 
point to it with the cursor, press and hold the mouse button, and drag the 
cursor up or down. 

Date Sets the date for the internal clock. You should only have to change 
the date after replacing the battery, since the clock automatically accounts 
for leap years. 

To set the clock, click on the month, day, or year and then use the up and 
down arrows that appear to the right of the date to increment or decre­
ment the selected unit. Notice that selecting either the date or time ele­
ments stops the internal clock while you make the changes. 

Rate Q{ Repeating Keys If you hold down a key on the keyboard, after a 
short delay the keyboard will act as if you are pressing the key repeatedly. 
Called auto-repeat, this control allows you to set the rate at which the 
character is repeated. A setting of 0 turns off auto-repeat. The maximum 
setting of 4 causes a repetition rate of about 10 characters per second. 

Time Used to change the current time of day on the Macintosh's inter­
nal clock. Set the time using the Date method. 

Command Blinking When you pull down a Macintosh menu and select 
a command, you may want visual feedback to assure you that the desired 
command was actually selected. You can use the Command Blinking con­
trol to cause the Macintosh to blink the selected menu entry up to three 
times before it actually performs the command. Set the control to 0 to 
disable the command blinking feature. 

Mouse Tracking Lets you set up the Macintosh cursor to track (that is, 
to mimic on the screen) the movement of the mouse in one of two ways. 
You can set the control to 0 and the cursor will always move in lockstep 
with the movement of the mouse. This is called constant or linear track­
ing. If you set the control to 1, tracking will be nonlinear. That is, if you 
move the mouse quickly, the cursor will move farther than it will if you 
move the mouse slowly. As you become adept with the mouse, nonlinear 
tracking can enable you to use the mouse in less desk space than you 
could with constant tracking. 
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Desktop Pattern Sets up your own custom background or desktop design 
for use with the Finder. To do this, point the cursor into the desktop 
pattern box at the bottom of the panel and click individual dots on or off. 
For example, if you point at a dot in the box and click the mouse button, 
the dot will turn off. Clicking the mouse button on a blank part of the 
box turns the dot for that area on. 

As you change the dots in the pattern box, the box to its right will show 
you the effect on the background. Once you have completed your back­
ground design, point the cursor at the box on the right and click the 
mouse button to "install" the new pattern. 

The pattern box consists of an 8 X 8 grid of dots. Using it you can design 
many different types of backgrounds. Believe it or not, in this simple grid 
you can set up any one of more than 18 billion-billion different desktop 
patterns. That is 18,000,000,000,000,000,000 choices. 

For example, you can use the first initial of your last name as the desktop 
background design. Using the three initials JTF and combining them 
into a single initial results in the pattern shown in Figure 2-4. The desk­
top pattern is saved on the system disk. This means that you can set up 
different desktop patterns on different disks. 

Keyboard Touch Lets you select the amount of time you will hold down 
a key before it starts auto-repeating. The higher the number, the more 
sensitive the keys, so the auto-repeat will start sooner. A 0 turns off 
au to-repeat. 

Double-Click Speed Many Macintosh applications (including the 
Finder) let you take shortcuts to certain commands by double-clicking the 
mouse button. The double-dick speed control lets you set the speed at 
which you need to click the mouse button in order for the Macintosh to 
recognize a double-dick. The rightmost setting of this control requires the 
fastest speed; the leftmost setting is the slowest. 

Rate Of Insertion Point Blinking Lets you set the rate at which the 
insertion point will blink. (See Chapter 3 for more information on the 
insertion point.) Selecting a l turns off the function. A 3 causes the inser­
tion point to blink at its fastest rate. 

Since each person has his or her own preferences about how things 
should work, the Control Panel accessory is very handy- you can set up the 
Macintosh's hardware to react the way you want it to. 
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The Puzzle, a game familiar to many of us from childhood, provides a small 
diversion from the serious work that you do on the Macintosh. Like the 
original game, it consists of movable tiles placed at random. For example: 
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The object of the puzzle is to rearrange the tiles in ascending order from 
left to right with the I in the upper-left comer. You can only move a tile that 
is adjacent to the single blank square. Move the tile of your choice by point­
ing at it with the cursor and clicking the mouse button. This is what the 
completed game should look like: 

The game starts with a different: random pattern each time you open it up 
from the desk accessory menu. So if you are almost finishing a game when 
your boss knocks on your door, you can choose between losing your efforts 
by clicking the puzzle's close box or getting caught playing the game. 
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In Part II you will look at MacWrite, 
a word processor package for the Apple 

Macintosh. You will see how MacWrite care­
fully ~lends the traditional features found 
in most modern word processors with the 

special Macintosh environment. The result is a 
breakthrough in ease of use and functionality. 

With a few exceptions, Mac Write offers the 
features found in most word processors, such as the 
ability to search through documents for occurrences 

of text, replace text, and automatically align margins. 



Operations requzrzng complex commands on other systems are 
accomplished very easily with NlacWrite. 

For example, scrolling (moving a document so that a different por­
tion appears on the computer display) can require a number of key­
strokes with most word processors. In MacWrite, the same thing is 
done with a simple movement of the mouse. Selecting a block of text 
can likewise require a good deal of activity at the keyboard. Again, by 
simply moving the mouse, you can accomplish the same thing with 
Mac Write. 

The mouse is used for everything but text entry in Mac Write. Icons 
(pictures) are used to represent objects like disks, and pull-down 
menus contain standardized commands that should be familiar to 
anyone who has used any other Macintosh applications package. 
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USING 
MACWRITE 

MacWrite takes a completely new approach to microcomputer-based word 
processing. By presenting many powerful features in an extremely friendly 
environment, MacWrite allows you to begin producing sophisticated docu­
ments almost immediately. This chapter discusses the features and options 
available with MacWrite. 

STARTING UP MACWRITE 

When you first start up MacWrite, you are greeted by the display shown in 
Figure 3-1. 

The insertion point is indicated by a vertical bar. When you type at the 
keyboard, the text is inserted (added) into your document at the insertion 
point. 

The menu bar contains seven pull-down menus listing different MacWrite 
commands. These menus and commands are discussed later in this chapter. 

The MacWrite ruler contains special information about the format of your 
document. Documents may contain one ruler that applies to the entire con­
tents or may contain many rulers that apply to specific portions of the doc­
ument. You will learn how to use rulers later in this chapter. 

33 
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Figure J-1. The parts of a MacWrite screen 

The title bar conta ins the name of the current document. This is the same 
type of title bar as that discussed in Chapter I. You can drag the entire 
MacWrite page around the screen by pointing the cursor at the title bar and 
then clicking and holding down the mouse buuon. You can close the 
current document by pointing the cursor into the close box at the left end of 
the title bar and clicking the mouse. 
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As you type the text, the size of the document will quickly exceed the size 
of the MacWrite display screen. The blank text area is a window through 
which you can see a portion of the document, about one-quarter of a printed 
page. You can view and edit different parts of your document by scrolling 
through it with the scroll bar. 

As in other Macintosh applications, the cursor is connected to the mouse. 
That is, as you move the mouse around, the cursor moves in the same pat­
tern on the screen. In MacWrite you use the cursor in conjunction with the 
mouse button to reposition the insertion point in a document as well as to 
select portions of the text for various editing functions (see "Inserting and 
Selecting Text"). 

The scroll bar is used to view different parts of a document. This is the 
standard Macintosh scroll bar as discussed in Chapter 1. The small square 
in the scroll bar indicates the relative position of the current window with 
respect to the entire document. For example, if you want to see a portion of 
text and you know that it is somewhere in the middle of a document, point 
the cursor at the small square, hold down the mouse button to select it, and 
drag it halfway down the scroll bar. This will position the window halfway 
through the document. 

If you point the cursor at the scroll bar but not at the small square and 
click the mouse, the document will scroll up or down, one windowful at a 
time. The direction of the scroll depends on whether you point above or 
below the small square on the scroll bar. 

The arrows at the top and bottom of the scroll bar let you browse through 
the document. When you click one of these with the mouse button, the 
document scrolls a line of text at a time. If you hold down the mouse button 
while pointing at one of these arrows, the document will continuously scroll 
to let you scan for a particular portion of text. 

INSERTING AND SELECTING TEXT 

To type text into a blank document, you can just start typing. The insertion 
point is automatically positioned at the beginning of the document. There is 
no need to press the RETURN key at the end of a line, as you do on a type­
writer. MacWrite ends a line with a complete word and then proceeds to the 
next line automatically. 

If you make a typing mistake as you enter text, use the BACKSPACE key to 
delete it and type in the correct text. The BACKSPACE key deletes the character 
immediately preceding the insertion point. 
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Once you have entered text into a document, you may want to edit it, 
repositioning the insertion point so you can add text or "selecting" portions 
of text to be changed or deleted. 

To move the insertion point to a particular part of a document, scroll the 
document until you can see the place where you want to insert text. Then 
point the cursor to the character position where you want to make the 
insertion and click the mouse button. Now you can type to your heart's 
content. Everything you type will be inserted after the insertion point. The 
rest of the document is shifted down to make room for the new text. 

You can select any or all of the text in a document for editing purposes. 
To select a word of text, move the cursor to point to a character in that word 
and double-dick the mouse button. This will cause the word to be displayed 
in "reverse video," that is, as white characters on a black background, rather 
than as the normal black characters on a white background. 

Any part of the text can be selected with the following procedure: 
(1) Move the cursor to the start of the text to be selected and click the mouse 
button. This will position the insertion point. (2) Now move the cursor 
down to point to the end of the text to be selected, scrolling the document if 
necessary. (3) Hold down the SHIFT key and click the mouse button. This 
will select the entire portion of text from the insertion point to the current 
cursor position. 

You can select the entire document by placing the insertion point at the 
start of the document, scrolling to the bottom, and holding down the SHIFT 

key while clicking the mouse button. 
Once a portion of text is selected, you can edit it in many ways. You can 

entirely delete the selected text by pressing the BACKSPACE key. You can also 
copy the selected text onto the system Clipboard or change the fonts, styles, 
and sizes of the characters. The editing commands that do this are discussed 
later in this chapter. 

PARAGRAPHS 

MacWrite treats the paragraph as the basic unit in formatting documents. 
For example, paragraphs are automatically formatted to fit within the mar­
gins you set. Because of its special status, you need to know exactly what a 
paragraph is in MacWrite. 

The smallest unit of text in MacWrite is the individual character. A 
MacWrite document is built up from characters that are grouped together in 
words. A word is a group of characters separated from another group by a 
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blank space or a special punctuation mark like a period, comma, hyphen, or 
a Return. (A Return character is a special character that MacWrite inserts 
when you press the RETURN key.) 

Words in MacWrite are grouped together in paragraphs, and paragraphs 
are combined to produce documents. A paragraph generally ends when you 
press the RETURN key. However, there are several other ways of specifying 
the end of a paragraph of text. These include 

• Insertion of a page break from the Format menu. 

• Insertion of a new ruler from the Format menu. 

• Insertion of a picture or graphics object from MacPaint or some other 
applications program (through either the system Clipboard or Scrap­
book). See Chapter 7 for more on this. 

• The beginning or end of a document. 

THE RULER 

The ruler contains all of the elements needed to set up the format of your 
document. Format includes features like left and right margins, tab stops, 
line spacing, and text alignment. 

The use of the ruler is really quite intuitive and easy to understand. The 
components making up the ruler are shown in Figure 3-2. 

Notice the ruler marker along the top of the ruler. This gives the ruler its 
name. Its primary purpose is to guide you in setting and changing the left 
and right margins, the indentation of the left margin, and any tab stops that 
you need. 

The left margin and indent tab markers set the position of the left side of 
each paragraph. The indent tab tells Mac Write where to start the first line of 
each paragraph, while the left margin marker specifies where the left margin 
should be set for the remaining lines of the paragraph. For example, if you 
want to indent the first line of each paragraph by half an inch, leave the left 
margin marker where it is but drag the indent tab to the right by half an 
inch. 

You can also drag the left margin marker to the right of the indent tab. 
This is handy for things like bulleted lists or numbered steps. For example, 
you can precede the first line of each paragraph with the hyphen character 
by using the margin settings shown in Figure 3-3. 
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The right margin marker sets the rightmost position of any text typed 
beneath the ruler. 

The tab stop indicates how far across the screen the insertion point will 
jump when you press the TAB key on the keyboard. You can set as many tab 
stops on the ruler marker as you need. The example in Figure 3-4 shows 
three tab stops. Press the TAB key once to move to the first position, twice to 
move to the second position, and three times to move to the third. 

To set tab stops, point the cursor to the tab stockpile and hold down the 
mouse button. This gets a new tab stop from the stockpile. You can then 
drag the tab stop anywhere ori the ruler marker and release the mouse but­
ton. To remove a tab stop, simply drag it off of the ruler marker and place it 
back into the tab stockpile. 

The decimal tab stockpile contains a reservoir of decimal tabs. A decimal 
tab is used to align the decimal points in a column of numbers. You can 
also use a decimal tab with alphabetical characters in order to align the 
rightmost characters in each line. As shown in the example in Figure 3-5a, 
you set up a decimal tab just as you would a normal tab. 
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Figure J-4. Tab settings in Mac Write 
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Both normal and decimal tabs have a special property that makes them 
extremely useful. When you press the TAB key to move the insertion point to 
the next tab position and then type in some text, the position of that text is 
tied directly to the tab. If you later move the tab, all of the text that is tied to 
that tab will move accordingly. This means you can type a multi-column 
table very quickly and with little regard for column positioning. After you 
finish typing the table, you can easily rearrange the columns so they are 
properly situated. For example, moving the tabs in Figure 3-5a just a bit will 
improve the table's appearance (Figure 3-5b). 

There are three line spacing icons in MacWrite. These are used to select 
single spacing, 1 1/2-line spacing, and double spacing for your text. You can 
change the current line spacing at any time by pointing the cursor to 
another line spacing icon and clicking the mouse button. The text follow­
ing the ruler will immediately be reformatted. 

MacWrite also has four text alignment icons: left alignment, center 
alignment, right alignment, and full justification. Each of these icons selects 
a different method of aligning or justifying the text of a paragraph. 

As mentioned earlier, when you type in text, MacWrite automatically ends 
each line after a complete word, so usually the right margin is not aligned. 
The text alignment icon tells MacWrite how to align the paragraphs follow­
ing the ruler. 

For example, selecting the left alignment icon causes all of the paragraphs 
to be aligned along the left margin. Selecting right alignment aligns the 
paragraphs along the right margin. Center alignment centers each line 
between the left and right margins. And full justification adds extra blank 
spaces between the words on each line so that both the left and right mar­
gins are aligned. Figure 3-6 shows an example of each. 

While you can use a single ruler to format an entire document, using 
multiple rulers provides you with real flexibility in arranging documents. 
You can place more than one ruler in a document by using the Format 
menu (discussed later). All of the text following a ruler is formatted accord­
ing to that ruler's settings until MacWrite encounters another ruler. 

By placing rulers throughout your document, you can easily intermix a 
variety of paragraph formats to suit your needs. \Vhen the document is later 
printed, the rulers do not appear. In Chapter 4, you will see an example of 
how multiple rulers can be used quite effectively. 

THE MENU BAR 

The MacWrite menu bar consists of seven pull-down menus: the desk acces­
sory menu (indicated by the picture of the apple in the upper-left corner of 
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LEFT ALIGNED: 
This is some sample text that demonstrates 
the differences of LEFT, CENTER, and RIGHT 
alignment as well as FULL justification. 
These differences are often more 
noticeable when using short margins, as in 
this example. 

CENTER ALIGNED: 
This is some sample text that demonstrates 
the differences of LEFT, CENTER, and RIGHT 

alignment as well as FULL justification. 
These differences are often more 

noticeable when using short margins, as in 
this example. 

RIGHT ALIGNED: 
This is some sample text that demonstrates 

the differences of LEFT, CENTER, and 
RIGHT alignment as well as FULL 

justification. These differences are often 
more noticeable when using short 

margins, as in this example. 

FULLY JUSTIFIED: 
This is some sample text that demonstrates 
the differences of LEFT, CENTER, and RIGHT 
alignment as well as FULL justification. 
These differences are often more 
noticeable when using short margins, as in 
this example. 

Figure J-6. Four ways of aligning text 

the screen) and the File, Edit, Search, Format, Font, and Style menus. The 
desk accessory menu is used to access the Macintosh desk accessories that 
were discussed in Chapter 2. 
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File Menu 

MacWrite documents are stored in files on disk. The commands in the File 
menu allow you to create new files, access information stored in existing 
files, and print MacWrite documents. 

New Opens up a new document. Any old documents must have pre­
viously been closed. The new document is untitled. 

Open... Opens up a document stored on disk. You will be given a list of 
the documents found on the current drive and prompted for the name of 
the document to be opened. If you want to open a document stored on 
another disk, click on the Eject button that appears or use the Drive but­
ton if you have an external disk drive. 

Close Closes the currently opened document. You will be given a chance 
to save any changes to that document before the closing process is 
completed. 

Save Saves a copy of the current document to disk. If the document has 
not been saved before, you will be asked to enter a name for it. Otherwise, 
the new version of the document will replace the old one. 

Save As Same as Save except that you will always be asked to enter a 
name for the document. This lets you save the new version under a differ­
ent name or on a different disk without losing the original. 

Page Setup Allows you to specify the size of paper to use for printing 
documents. To change the current selections, simply point the cursor at 
the appropriate button and click the mouse button. The default settings 
(those set up by the program when you start it up) are as follows: 

Paper: ® US Letter 

0 US Legal 

Orientation: ®Tall 

0 R4 Letter 

0 International Fanfold 

0 Tall Adjusted 0 Wide 

OK 

( Cancel ) 



44 I Using MacWrite and MacPaint 

The types of paper you may use are 

U.S. Letter- U.S. standard, 8 112" X 11" 
A4 Letter-European standard, 8 1/4" X 11 2/3" 
U.S. Legal- U.S. legal size, 8 112" X 14" 
International Fanfold-8 114" X 12" 

The orientations you may select are 

Tall- Normal printing (left to right) 
Tall Adjust- Compensates for distortion 
Wide- Prints page sideways (top to bottom rather than 
left to right) 

Print Lets you print the document. You will be given the chance to set 
the following options: 

Quality: @High 0 Standard 0 Draft OK 
Page Range: @All 0 From: D To: D 
Copies: D 
Paper Feed: @ Continuous 0 Cut Sheet ( Cancel ) 

Print Quality-The higher the print quality, the slower the printing. The 
High selection will give you even better looking text than that seen on the 
Macintosh display. Selecting Standard quality results in printouts identi­
cal to the screen. The Draft option is very fast, prints only text, and uses 
only one font, one character size, and the Bold and Underline styles. 

Page Range- Lets you print all of the pages of the document or selec­
tively print certain pages. 

Number of Copies-Lets you print as many copies of the document as 
you desire. 

Paper Feed-If you specify Continuous, MacWrite will proceed to print 
all of the pages without pause. If you select Cut Sheet, MacWrite will 
pause between each page to let you put a sheet of paper into the printer 
before it continues printing. 
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Quit Lets you leave MacWrite and return to the Finder. You will be 
given the chance to save any changes to the current document before leav­
ing MacWrite. 

Edit Menu 

The Cut, Copy, and Paste commands found in this menu work with the 
system Clipboard. Using these commands, you can easily move large chunks 
of text within a document or even to other documents. Furthermore, the 
Clipboard can be used to move graphics created in MacPaint into a Mac­
Write document. See Chapter 7 for more information on the system Clip­
board and how to use it. 

Undo If possible, undoes the effects of the last MacWrite command. 

Cut Removes a selected portion of text from the document and places it 
onto the system Clipboard. 

Copy Makes a copy of a selected portion of text and places it on the 
Clipboard. The document itself is left unchanged. 

Paste Places a copy of the current contents of the Clipboard into the 
document at the insertion point. The Clipboard contents are unchanged. 

Show Clipboard Displays the Clipboard window with its current 
contents. 

Search Menu 

The commands in the search menu allow you to search for words, phrases, 
or other strings of text. This can come in handy when you need to quickly 
find all occurrences of a word or phrase in a long document. You can also 
use the Search menu to replace one sequence of characters with another. 

Find... Lets you search for all occurrences of a string of characters. You 
will be prompted for the character string to search for. If you want to use 
Find to search for the next occurrence of the same text, you can simply 
click the Find Next button that is displayed. 
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You have the option of searching for a whole word or for a partial word 
that may be embedded within another word. 

Change... Similar to Find except you can also specify a text string that 
will replace occurrences of the Find string. You can indicate whether you 
want to change only the first occurrence, change the first occurrence and 
look for the next, or change every occurrence in the document. 

Format Menu 

The commands in the Format menu allow you to control the format of your 
document: the margins and tabs, headings and footings, page numbers, and 
the beginning and end of pages. 

Insert Ruler Creates a new ruler and places it in your document at the 
insertion point. 

Show Rulers/Hide Rulers Allows you to turn on or off the display of 
rulers in your text. The rulers will not be printed in the document, so 
turning them off (hiding them) lets you see the document as it will appear 
when printed. Turning the rulers on (showing them) lets you see and 
change their settings. 

Open Header Opens the header window to allow you to set up a header 
to be displayed at the top of each printed page of your document. See the 
section on Headers and Footers later in this chapter for more information. 

Open Footer Opens the footer window to let you set up a footer that will 
be displayed at the bottom of each printed page of your document. 

Display Headers/Remove Headers Selecting Display Headers causes the 
contents of the header window to be placed at the top of each page of the 
document. If you select Remove Headers, the header will not be used. 

Display Footers/Remove Footers Selecting Display Footers causes the 
contents of the footer window to be placed at the bottom of each page of 
the document. If you select Remove Footers, the footer will not be used. 

Set Page# Lets you set the starting page number. Page numbers can be 
printed in either headers or footers. 
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Insert Page Break Forces the next page to begin at the insertion point. 
This can be used for such things as chapter breaks in a report, if you want 
to start each chapter at the beginning of a new page. 

Title Page This is a switch that you select to turn it on and reselect to 
turn it off. When it is on (signified by a check mark next to the command 
in the Format menu), the first page of the document is assumed to be a 
title page, and no header or footer will be included on that page. When 
the switch is off, no title page is provided for. 

Font Menu 

The Font menu allows you to select a character font. If you have any text 
selected when you change the font, all of the text will be changed to the new 
font. After selection of a new font, all text typed in will be displayed in that 
font. Some of the available fonts are shown in Figure 3-7. 

Style Menu 

The Style menu lets you select from a variety of character styles and sizes. If 
you change the style or size for some selected text, all of the selected text will 
be changed to that style or size. All of the text you type after a style or size 
change will reflect that change until you select another style or size. 

There are eight styles from which to choose. MacWrite's selection of styles 
and sizes are shown in Figure 3-8. The first, Plain Text, cancels any of the 
other styles. The five styles can be mixed together in any combination. The 
last two styles cannot be selected together. This gives you a total of 96 differ­
ent styles to choose from. 

HEADERS AND FOOTERS 

MacWrite allows you to place a header or footer in your document. A header 
(or footer) is information in the top (or bottom) margin of each page. You 
can use a header or footer to place the current page number, the current date, 
or even the current time into every printed page in a format that you specify. 

Once you set up a header or a footer in your document, MacWrite will 
automatically include it on every page of your document. An exception to 
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Chicago Font 

Geneva Font 
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Toronto Font 
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Figure J-7. Fonts available with Mac Write 

this occurs when you select the Title Page switch in the Format menu. In 
this case the header or footer will not appear on the first page. 

A document can have both a header and a footer or just one or the other. 
You set up a header or footer by selecting the Open Header or Open Footer 
commands from the Format menu. This causes MacWrite to open a header 

window or a footer window. The header window is shown in Figure 3-9. 
A header window is separate from the MacWrite document window in 

which you normally en ter text. You can en ter up to six Jines of text in the 
header window. All o f the MacWrite facilities for selecting text, changing 
character fonts, styles, and sizes, and even accessing the system Clipboard to 

bring in text or graphics objects from other applications are avai lable. (See 
Chapter 8 for an example of using the header to set up a letterhead created 
with MacPaint.) 

Notice the three small icons in the header labeled Page Number, Date, and 
Time Of Day. These special features place the current page number, date, or 
time of day into the header. To use any of these, simply point the cursor to 
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Figure J-8. Type styles and sizes available with MacWrite 
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the appropriate icon, click and hold down the mouse button, and drag the 
icon to the position in the header where you want the information placed. 

Once you set up these icons, you can forget about them. Later, when you 
edit or print your document, MacWrite will insert the proper page number, 
the current date, or the time of day into the header positions that you 
indicated. 

To prevent the header from appearing on the screen and on the printed 
page, select the Remove Headers command from the Format menu. Hiding 
the header in this way will not destroy the header information. If you later 
select Display Headers, the previous header information will appear on each 
page of the document. 

The capabilities of the footer are identical to those of the header. You can 
use the page number, date, or time-of-day icons and intermix them with text 
that you type into the footer window. 

In Chapter 4, you will see an application that uses both the header and 
footer in a document. 



C H A P T E R F 0 U R 

REPORT WRITING 
WITH MACWRITE 

This chapter takes a look at the art of writing reports. The first section 
discusses general guidelines that can help improve the quality of your writ­
ing on any word processor. The remaining pages describe techniques that 
can be used specifically with MacWrite. 

All kinds of people-not just students and businesspeople-read and 
write reports, so it is worth the time and effort to look at some common 
ways in which reports can be improved. The guidelines and MacWrite tech­
niques discussed in this chapter are by no means limited to use in business 
or technical report writing. They can be applied to virtually any type of 
writing: memos, books, short stories, articles, and even personal and busi­
ness letters. 

A FEW GUIDELINES 

Two fundamental goals of good report writing are simplicity and organiza­
tion: Your documents should be simple and organized logically. The general 
guidelines that follow can help you achieve these goals whether you use 
MacWrite or some other word processor. 

• Divide the document into logical divisions. Then divide each section 
into subdivisions. Keep dividing as long as it is feasible. For example, 

51 
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this book is divided into five parts, each part divided into chapters. 
Each chapter is divided into sections; some sections include subsections. 

This technique will help both you and your reader. As a writer, you 
will be forced to be organized in order to establish the divisions in your 
report. If you begin to wander aimlessly in your writing, it will quickly 
become apparent. Likewise, your reader will be better able to follow the 
flow of the report. Logically placed divisions let the reader know when 
a discussion is finished and a new one is about to begin. They also help 
break up the report visually, making the report easy to read. 

• Give a descriptive heading to each division and subdivision of your 
document. Headings help the reader understand the organization of the 
document. A concise yet descriptive heading tells the reader at a glance 
what the following portion of the document is going to discuss. The 
reader is then free to read it or skip to the next section. 

• Use simple, short sentences and simple, short paragraphs. It is easier to 
absorb ideas in many small doses than in a few large ones. 

• Make judicious use of space throughout the document. You can take 
advantage of varying margin widths and blank spaces left between 
headings to organize a document spacially, as well as to place emphasis 
on certain portions of text. 

• Include illustrations whenever possible and appropriate. Illustrations 
not only break up the report visually, they also give you the opportuni­
ty to reinforce the message in your report. As you will see in later chap­
ters, you can use the power of MacPaint to illustrate reports written 
with MacWrite. 

• Use an informal, conversational tone of voice. Try to get a mental 
image of the "average" reader of your report, be it a manager at work, a 
professor or teacher at school, or someone else. Write as if you were 
having a casual conversation with that person (although take care not 
to overdo it). 

• Let your readers know where they have been and where they are going. 
Whenever it is feasible, introduce a new subject, discuss it, and then 
summarize it. 

The rest of this chapter discusses a variety of techniques for wnung 
reports with MacWrite. Later chapters will discuss some of these techniques 
in more detail. 
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REPORT HEADINGS 

In organizing your reports, you will want to include multiple levels of head­
ings. The use of unique level headings (the group of headings for one par­
ticular level of a report) can help guide the reader as well as make it easy to 
identify the various levels of division. 

For example, consider a report that uses three levels of headings, each 
printed in a distinctive heading style. The headings at the first level identify 
the main sections of the report. The second level headings describe the sub­
sections. The third level headings identify the subsections of the subsections. 
The level headings should be designed so that the reader does not have to 
make a conscious effort to determine the level a given heading is on. 

One problem with many word processor packages is that they tend to 
restrict your ability to create appealing and distinctive level headings in your 
reports. Because they offer only one character size, font, and style, you must 
usually resort to a numbering scheme to identify the levels of headings you 
are using. For example, you might identify them with roman numerals: "I." 
for level one, "II." for level two, "III." for level three, and "IV." for level 
four. There is nothing wrong with this approach, but the numbers add clut­
ter and can make divisions seem less natural to the reader. 

MacWrite offers a number of tools that can be used to create level headings 
to subtly yet clearly differentiate between the different levels of a report. For 
example, at the highest division level, you can use large boldfaced charac­
ters, perhaps in uppercase and centered on the page. In creating the lower­
level headings, you can incrementally reduce the size of the characters, 
introduce lowercase characters, and move the position of the headings. 

PROJECT 

CREATING A REPORT 

Let's look at how you might use level headings to design and write a report 
with MacWrite. The process is fairly simple and yet may be a little confus­
ing the first time you try it, so it is worth working through here. 
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Having analyzed the topic of your report and developed an outline, you 
see that the report needs to contain three levels of headings. An example of a 
three-level heading design is shown in Figure 4-l. 

One important feature used in creating this example is the ruler, which 
was discussed in Chapter 3: 
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Recall that the ruler is set for left and right margins, automatic paragraph 
indentation, normal and decimal tabs, line spacing (single, 1 1/2, and dou­
ble), and text alignment (centered, left-, right-, or fully justified). You can 
insert new rulers anywhere within a MacWrite document by using the Insert 
Ruler command in the Format menu. A ruler formats text according to its 
settings until another ruler or the end of the document is encountered. 

In other words, every time you want to alter the format of a portion of 
text, you need to insert a new ruler just before the text itself. This is also true 
for level headings in your report. You will need to place a ruler just before 
each heading to position it properly. In addition, you will need to place 
another ruler immediately after the heading to position the body of text that 
follows. 

You can create the sample shown in Figure 4-1 by following these steps: 

Step I. Start up MacWrite and get a blank page on which to begin writ­
ing. Can you see the initial ruler at the top of the page? If not, 
pull down the Format menu and select the Show Rulers 
command. 

Step 2. The initial ruler will be used for setting up the report's title. The 
only change that needs to be made to the ruler's default (start up) 
settings is to select the centered alignment icon. Do this by mov­
ing the mouse so that the cursor arrow points to the centered 
alignment icon in the ruler and then clicking the mouse button. 

You also need to select a text style format for the report title. For 
this example, pull down the Font menu and select the Athens 
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8 HIERBRCHICBL BPPRDBCH TO WBITIDG 

This example demonstrates the use of several 
different levels of division in a report. The title of the 
report uses Center Aligned text with Athens font~ 
Bold style~ and 18-point characters. 

OUTER LEVEL HEADINGS 

The outer level headings mark the major sections 
of the report. The heading above uses Center Aligned 
text with the Geneva font~ Bold and Underline styles~ 
and 14-point characters. 

SECOND LEVEL HEADINGS 

The second level headings mark the subsections 
of the the main report. This heading uses the Geneva 
font~ Bold style~ and 14-point characters~ and is 
aligned with the left margin. 

Third Level Headings 

The third level headings further subdivide the 
report. In this third level section~ the margins 
were changed to further accentuate the division. 

Figure 4-1. A report with three levels of headings 
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font. Pull down the Style menu and select the Bold style and 18 
point character size. Now you can type in the title o~ the report as 
follows: 

R HIERRRCHICIJL RPPRORCH TO WRITinG 

Step 3. Next, set up another ruler for the introductory paragraph of the 
report. First press the RET URN key a couple of times to add a 
blank line between the title and the text. Pull down the Format 
menu and select the Insert Ruler command. You will see a new 
ruler appear at the insertion point of your document. Select the 
full justification icon in this new ruler. Now point the cursor to 
the indent tab marker, hold down the mouse button, and drag 
this marker to the right of the left margin marker so tha t the first 
line of each paragraph will be indented. 

Use the Font and Style menus to select the style of tex t for the 
introductory paragraph of the report. This example uses the 
Toronto font, Plain style, 12 point. You can now type the intro ­
ductory paragraph. 
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R HIERRBI:HII:RL RPPRORI:H TO WRITinG 
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This example demonstrates the use or several 

d t!!erent levels or dtvision in a report The tttle or the 
report uses Center Aligned text w ith Athens font , 
Bold style, and 18-point characters . 

Step 4. You may see that a pattern is being established. For every heading 
in your report, you insert and set up a ruler to contro l the format 
of the heading, change the character font and style as desired, and 
type in the heading. You then insert and set up another ruler that 
formats the paragraphs that follow, change the character font and 
styles again, and type in the text. 

NOTE: T he rulers are not printed with your text. T hey are only visible 
on your Macintosh display. If you want to see what your report will 
look like when it is printed without the rulers, p ull down the Format 
menu and select the Hide Rulers command. 

If the process of setting up numero us rulers and different character fonts 
and styles sounds a bit tedio us to you, you are righ t. In addi tion, you must 
take specia l care to ensure that a ll the headings of a given level have the 
same ruler and character settings. Bu t there are some things you can do to 
reduce the difficu lty of setting up a report with multiple heading levels. 

First, rulers can be selected and duplicated by using the Copy commands 
in the Edit menu in exactly the same way as with any text in a MacWrite 
documen t. You can use Copy and Paste to duplicate the ruler and character 
style assignmen ts from one heading to a nother. An a lternate method is to 
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copy the complete heading for a given level and paste it elsewhere in your 
document where another heading of the same level is needed. In this way 
you copy all of the ruler settings and text character styles of both the head­
ing and the subsequent body of text. 

When defining the first heading for a given level, you will have to use the 
steps outlined previously. Afler that, however, you can simply Copy the first 
heading and Paste it into position for the next heading. A quick job of 
editing the text will result in the desired heading. 

You begin the Copy and Paste process by selecting the following: the ruler 
preceding the heading, the text of the heading itself, the ruler fo llowing the 
heading, and the first character of the body of text that comes after the head­
ing. (NOTE: ll helps to select the first character of the body of text because 
that character con ta ins all of the font and style information for the body of 
text. ) 

For example, you can select the initial occurrence of the second level head­
ing like this: 

second level headings mark the subsections 
of the the main report . T11is heading uses the Geneva 
font, Bold style, ancl 14-point cl•aracter-s, ancl is 
aligned with the lett margin . 

., 

Use the Copy command to place this text onto the system Clipboard. 
Move the insertion point to the part of the document where the new second 
level heading is to go; then Paste the heading material into the document. 
Now you can select the text that makes up the heading and replace it with 
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that of the new heading. Finally, move down to the first character of the 
body of text, select it, and replace it by typing in the new text. 

Another way to create headings is to design the headings after the report is 
finished. As you write the report, add a label lO identify the level of each 
heading (for example, Ll, L2, and L3) but do not insert rulers or specify 
character fonts or styles for the headings. Then, after the report is written, 
you can use the Find command (in the Search menu) to locate all Ll, L2, 
and L3 headings and use the Copy and Paste commands to set up the head­
ing formats. 

TEXT HIGHLIGHTING 

Highlighting text is an effective way of emphasizing an important word or 
thought in your text. Mac Write provides a great variety of methods that you 
can use to highlight text. For example, you can use different character styles, 
fonts, and sizes to highlight text in your document, as demonstrated in 
Figure 4-2. 

When you want to highlight particular words or 
phrases, mac Write offers a wide variety of choices. For 
example, you can italicize words and set. other words 
in boldface. You can even co.mbine the italics and 
bold styles 

Other character styles include the under line, 
@Ufr,llflnt®, superscripting, subscripting, and~- Of 
course you can mix any of these styles at your pleasure. 
You should lH®~Il131 ~{,2 not to rtilriP'tiJ 
your~l:o-

Aside from using styles, you can intermix different 

character sizes and use a uaritt)! of fonts too. 

Figure 4-2. Highlighting text 
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You can highlight a word or phrase as you type the document, or you can 
type a section of text and then go back and emphasize the appropriate items. 
To set up highlighting as you type in text, pull down the Font and Style 
menus to select whatever character settings are to be used for emphasis and 
then type in the text. When you are through entering the emphasized text, 
"deselect" the emphasis, that is, change the Font and Style settings back to 
whatever you were using for normal text. 

It is often easier to set up highlighting after you have finished with a 
portion of the document, perhaps after finishing a paragraph or even after 
typing a full section of text. You can then go back and easily edit the por­
tions of text that are to be emphasized. For example, suppose that you have 
just finished typing the following paragraph: 

This chapter deals with two fundamental 
elements of good writing; simplicity and 
organization. The structure of any document should 
be well organized and simple to follow. The use of 
any of the various techniques presented in the 
chapter should be carefully selected in such a way 
as to attain the desired results without being too 
obtrusive to the reader. The final goal is, after all, to 
get some idea or message across to the reader. 

You decide that the keywords simplicity and organization are so important 
that you do not want the reader to overlook them. You also want to empha­
size the entire last sentence of the paragraph. You can quickly highlight 
them once you have typed the paragraph. Select the text to be emphasized 
and then use the commands in the Font and Style menus to effect the 
change. In the current example, you have to make three different selections 
and changes for emphasis. 

Here the text has been highlighted by using the Italic and Bold character 
styles: 

This chapter deals with two fundamental 
elements of good writing; si.rnp.licitgand 
organization. The structure of any document 
should be well organized and simple to follow. The 
use of any of the various techniques presented in the 
chapter should be carefully selected in such a way 
as to attain the desired results without being too 
obtrusive to the reader. The fino./ goo./ is~ after 
o./.1~ to get so.rne ideo or .message across to 
the reader. 
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Another effective highlighting technique, the use of the MacWrite indent 
tab to create a bulleted list, was discussed in Chapter 3. A slightly different 
application of this technique is to set off a sequence of instructions that you 
would like to explain to the reader. 

For example, there are times when you might wish to set off each step of a 
chain of events so that the reader can easily follow along. Figure 4-3 shows 
an example of a ruler that will set off a series of steps. 

MacWrite's many other text-highlighting techniques can be very effective 
when used properly. For example, you can set a very special thought or 
warning off by itself by building a highlight box around the text. Figure 4-4 
shows what a highlight box might look like. Chapter II demonstrates how 
to combine the capabilities of MacPaint and MacWrite to create 
professional-looking and eye-catching highlight boxes. 

r • File Edit Search Format Font Style 
., 

:o Untitled 
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Step 1. The object of breaking a discussion into a 
step-by-step analysis is to make it easy for the 
reader to follow. 

Step 2 Each step should be stated simply and should 
describe a single idea or action 

Step 3 Notice how easy 1t is to set up these steps with the 
MacWrite ruler and the indent marker. 

Figure 4-J. Using the indent marker to set off a series of steps 

Ill: 

1!··1! 

1111! 
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A highli6>h t b ox may consist 
of bars that separate a portion 

of text from the rest of the 
document. 

Figure 4-4. A highligh t box created with MacWrite 

r • File Edit Seorch Format Font Style 
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Figure 4-5. Header and footer for a report 

-
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HEADERS, FOOTERS, AND TITLE PAGES 

You can use MacWrite to set up headers and footers as well as a title page 
(with or without the header and footer) that identifies the report and author. 

You saw in Chapter 3 that the header and footer in MacWrite can be inde­
pendently turned on or off for your report. Either one can automatically 
insert the current page number, the date, and the time of day into a 
document. 

Let's now see how headers and footers work. Suppose you would like to 
number each page of your report. If you save each chapter of the report in a 
separate MacWrite file, you can set up the report so that each page identifies 
the chapter number and title as well as the page number. 

As an example, you can use the footer and the header shown in Figure 4-5. 

This page demonstrates the use of the 
header and footer on a page of text. notice that 
the page number at. t.he bot.t.om of t.he page 
includes the chapter number too. 

You can include up t.o six lines of text in 
both the footer and the header if you wish. You 
can even use macPalnt. t.o create some special 
graphics object. and move that. object.int.o t.he 
footer or header. See Chapter 8 for an 
application t.hat shows how this is done. 

You can use any combination of the 
mac Write character fonts. st.yles, and sizes in 
your header and footer. You can even set. up 
the header and footer icons (page number. Ume 
of day, and date) t.o display their information in 
ahy desired font., style, and size by selecting the 
icon in the normal way and t.hen setting up t.he 
desired attributes. 

4-1 

Figure 4-6. Sample page with header and footer 
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Here the chapter heading has been placed in the upper-right corner of each 
page and the chapter page number in the lower center. A sample page is 
shown in Figure 4-6. 

Of course, your own personal preference will determine whether you want 
to use a footer or a header in a report. Remember that if you want to prevent 
the footer and header fro111 appearing on the first page of the document, you 
can turn on the Title Page option found in the Format menu. 



P A R T T H R E E 

MacPaint can best be described as a 
graphics processor. just as a word processor 

is designed for entering and manipulating 
text, a graphics processor supports the creation 

and manipulation of graphics images. 
MacPaint is a multifaceted program. 

It contains a selection of structured tools to 
design structured objects, as well as an 

array of painting and sketching tools for doing a 
wide range of freehand designing. Blending the 

tools of the architect and the artist, MacPaint 
gives you the power to create virtually any graphics image. 



C H A P T E R 

USING 
MACPAINT 

F I V E 

MacPaint is a free-format graphics processor. When you first start it up, you 
are given a blank screen, or canvas, on which you can create almost any 
shape or form that you desire. This chapter introduces all of the tools and 
features of MacPaint. 

A TOUR OF THE MACPAINT SCREEN 

When you first start MacPaint, you should see the screen that is shown in 
Figure 5-l. 

Along the top of the screen are the pull-down menus found in most 
Macintosh applications. The left side of the screen contains a tool palette, a 
selection of MacPaint tools that can be used for creating and editing graph­
ics objects. The lower-left corner contains a line width palette, which lets 
you specify different line widths for use with some of the tools. The bottom 
of the MacPaint screen contains a pattern palette, 38 different patterns that 
you can use to fill and shade areas or objects on the screen. 

MacPaint does not show you the whole canvas at once. Instead you see a 
window that displays about a fourth of the canvas. The commands discussed 
later in this chapter will provide ways to examine the entire canvas and to 
print it out. In the next section you will see how to move the canvas around 
to display a certain area in the window. 

67 
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THE TOOL PALETTE 

There are 20 tools available in the tool palette. Some tools have several varia­
tions to choose from. 

,...-, 
LASSO-+ I I ~ SELECT ION RECTANGLE L--' 

GRABBER -+ ~ TEXT 

PAINT BUCKET -+ ~ SPRAY PAINT 

PAINT BRUSH-+ ~ PENCIL 

LINE-+ ........... g ~ ERASER 

BOX-+ D • ~ FILLED BOX 

ROUNDED BOX -+ 0 • ~ FILLED ROUNDED BOX 

QUAL-+ 0 • ~ FILLED QUAL 

FREEFORM -+ C? • ~ FILLED FREEFORM 

POLYGON-+ a ~ ~ FILLED POLYGON 

To select a tool, move the cursor so that it points to the tool in the tool 
palette. Click the mouse button. Now you can move the cursor back onto the 
window to use the tool. 

Lasso Draws a "rope" around a shape or group of shapes on the win­
dow. Hold down the mouse button while you draw the rope. Release the 
mouse button so that the rope will tighten up to select the shape or shapes 
within the area encircled by the rope. You can now do the following: 

Move- Position the cursor within the selected shape until the cursor 
changes into an arrow. Press the mouse button and drag the shape to the 
desired position on the window. 

Copy-Press the OPTION key and hold it down while you drag the object. 
Makes a copy of the selected shape and moves the copy. 

Multiple Copy- Hold down the OPTION and COMMAND keys while you 
drag the object. This makes a number of copies of the selected shape and 
leaves them scattered along the path that you make with the cursor. See 
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r a File Edit Goodies Font FontSize 
., 

-· 
Figure 5- J. MacPaint startup screen 

"Selecting Line Widths," la ter in this chapter, for information o n setting 
the spacing lO separate each copy. 

Clear-Select the Clear command from the Edit menu lO erase the 
selected shapes. 

Invert-Select the Invert command from the Edit menu to invert the 
selected shapes. 

Selection Rectangle Lets you draw a dotted rectangle on the screen lO 

select an entire region. Move the cursor lO one corner of the region you 
want lO select. Hold down the mouse button and drag the selection rec­
tang le over lO the opposite corner. Release the mouse button. 

You can do the same operations that you can do with the Lasso tool as 
well as execu te the Trace Edges, Flip Horizontal , Flip Vertical, and Rotate 
commands found in the Edit menu (discussed later in this chapter). 
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In addition, if you hold down the COMMAND key, and then press and hold 
down the mouse button, you can stretch or shrink the selected object by 
dragging the mouse in the appropriate direction. 

Grabber Lets you reposition the MacPaint canvas so you can see any 
part of it through the window. Using the Grabber is similar to looking 
through a microscope and using your hand to move the slide you are 
examining. To move the canvas, position the Grabber in the window and 
hold down the mouse button. Drag the canvas around to the position you 
want. Releasing the mouse button will set the new canvas position and 
cause the screen to be updated. 

Text Selects text entry mode. Move the cursor to the desired location on 
the window and click the mouse button to set the insertion point. Now 
you can type in text from the keyboard and use the Font, Fontsize, and 
Style menus to select a particular font, type size, and style. 

Paint Bucket Provides an area jill function. Select a desired pattern from 
the pattern palette and position the paint bucket in an enclosed shape on 
the window. Click the mouse button, and the entire area will be filled 

· with the pattern. 

The area to be painted must be completely enclosed by a solid border. If 
the border is broken at any point, the paint will "leak" out and spill into 
other areas of the screen. 

Spray Paint Lets you spray paint on the window. You can select different 
patterns from the pattern palette to spray onto the screen. To paint, hold 
down the mouse button as if it were a real can of spray paint. 

Paint Brush Gives you a paint brush for freehand painting on the win­
dow. If you hold down the SHIFT key, you can constrain the paint brush to 
draw straight horizontal and vertical lines. Choose from a selection of 32 
different paint brushes by double-clicking on the paint brush or via the 
Brush Shape command in the Goodies menu. You may choose the "color" 
of the paint from any of the patterns in the pattern palette. 

Pencil Gives you a fine-edged pencil for freehand writing. Results in 
black writing on a white background or white writing on a black back­
ground. Especially useful for touching up graphics objects with the Fat­
bits command in the Goodies menu. As with the paintbrush, if you hold 
down the SHIFT key you can constrain the pencil to draw straight horizon­
tal and vertical lines. 
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Line Provides you with an easy way to draw straight lines. After select­
ing the line tool, move the cursor to the window and press the mouse 
button at the starting point of the line you wish to draw. Hold down the 
button as you move the cursor to the end point of the line. The line will 
follow the cursor until you release the mouse button. 

Eraser Like a chalkboard eraser. Move the eraser out to the window and 
hold down the mouse button while you erase the appropriate areas. You 
can erase the entire contents of the window by double-clicking on the 
eraser. For very detailed erasing, use the eraser with the Fatbits command 
found in the Goodies menu. 

The following tools are collectively known as shape tools. They are used 
to draw specific types of shapes: 

Box Allows you to draw a box or rectangle easily. Position the cursor at 
the starting point and hold down the mouse button as you move the 
opposing corner of the box out to its final position. To draw perfect 
squares, hold down the SHIFT key and then hold down the mouse button 
while dragging the cursor around the screen. 

Filled Box Just like the box, except the inside of the rectangle is filled 
with whatever pattern is selected from the pattern palette. 

Rounded Box Like the box, except the corners of the box are rounded. 
Holding down the SHIFT key while dragging the cursor produces a square 
with rounded corners. 

Filled Rounded Box Just like the filled box, except the corners of the 
rectangle are rounded of£. 

Oval Allows you to draw an oval easily. Position the cursor at the start­
ing point. Hold down the mouse button, and drag the mouse until you 
have an oval of the proper dimensions. You can hold down the SHIFT key 
while dragging the mouse to draw perfect circles. 

Filled Oval Like the oval, except the resulting oval is filled with the 
pattern selected from the pattern palette. 

Freeform Allows you to draw freeform shapes. Works like the paint 
brush, except line thickness is controlled by the line width palette. 

Filled Freeform Like freeform, except shapes are filled with the pattern 
selected from the pattern palette. You hold down the mouse button to 
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draw. When you release the button, the starting and ending points of the 
line are automatically joined and the shape is filled. 

Polygon Allows you to create a polygon with a series of lines. Position 
the cursor and click the mouse button to set the starting point. The cursor 
will now control a line emanating from the last point set. Move the cursor 
to each successive vertex and click the mouse button to set a new point. 
The polygon will be complete when you join the start and end points. 

Filled Polygon Like the polygon, except interior areas are filled with the 
pattern selected from the pattern palette. 

SELECTING LINE WIDTHS 

The five choices in the line width palette affect the width of the lines drawn 
by the line tool and all of the shape drawing tools (box, oval, and so forth). 
For the filled-shape drawing tools, the dotted line choice will create filled-in 
shapes without border lines. The selected line width also determines the 
spacing for the multiple-copy features of the lasso and selection rectangle 
tools. The heavier the line width, the more space separating each copy. 

If you press and hold down the OPTION key before using the line tool or 
any of the various shape tools, the currently selected pattern in the pattern 
palette will be used to draw the lines. 

PULL-DOWN MENUS 

MacPaint has seven pull-down menus that work the same as those in any 
other Macintosh application-namely, you pull down the menu by point­
ing the cursor at the menu and pressing and holding down the mouse 
button. 

Each menu contains a selection of commands. You execute a command by 
pointing to it with the mouse button held down and then releasing the 
button. The apple icon in the upper-left corner of the MacPaint display 
gives you access to the desktop accessories (see Chapter 2). The remaining 
pull-down menus are File, Edit, Goodies, Font, Fontsize, and Style. 

File 

The commands in the file menu allow you to save and retrieve MacPaint 
documents in disk files. The menu also includes commands for printing 
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files on the printer and for exiting the MacPaint program. 

New Provides a blank canvas for you to work with. You must have 
removed the existing canvas earlier via the Close command. 

Open... Selects a MacPaint document to be read from disk. Gives you the 
option of ejecting the current system disk in order to read a document 
from another disk. Like the New command, any existing canvas must be 
closed before you can use Open. 

Close Removes the current canvas from the MacPaint display. Gives you 
the opportunity to save any changes made on this canvas to disk before 
discarding the canvas. Use New or Open to request another canvas. 

Save Copies the current canvas to disk. If this is the first time it is saved, 
you will be prompted for a name to be given to the canvas. Otherwise, the 
canvas will be saved under its current name, thereby overwriting the ear­
lier version. 

Save As... Same as Save, except you will always be asked for a name to 
give to the canvas. If you want to keep both the previous and current 
versions, use this command instead of Save and give the new version a 
different name. 

Revert Discards all changes made to a canvas since it was last saved on 
or read from the disk. If this canvas was never saved on disk, you will get a 
blank canvas. Otherwise, the old version of the canvas will be read in 
from disk. 

Print Draft Prints out the current canvas on the printer. The printed 
results are not quite as clear as Print Final produces, but the printing task 
is accomplished in less time. 

Print Final Prints out a high resolution copy of the current canvas. 
Print Final offers more clarity than Print Draft. 

Print Catalog Prints a catalog of all MacPaint documents stored on the 
current disk. Each document is printed as a compressed 1- by 1 1/4-inch 
picture. Up to 25 pictures are displayed on a printed catalog page. 

Quit Lets you leave MacPaint and return to the Finder. If you have a 
canvas with unsaved changes, you will be given a chance to save the can­
vas on disk before quitting. 
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Edit 

You use the commands of the Edit menu to help you modify existing objects 
in the MacPaint window. All of the commands in the Edit menu (except for 
Undo) work on areas or objects that have been selected with the selection 
rectangle or the lasso. 

Undo Undoes your last MacPaint operation. For example, if you erase 
something and then want to return it to the window, you can restore it by 
executing the Undo command. You can only restore the most recently 
completed operation. 

Cut Removes the selected area from the MacPaint window and transfers 
it to the system Clipboard. The selected area is blanked out on the 
window. 

Copy Makes a copy of the selected area and places it onto the system 
Clipboard. The MacPaint window is left unchanged. 

Paste Makes a copy of whatever is on the system Clipboard and places it 
in the MacPaint window. The object is automatically selected by using 
either the selection rectangle or lasso. You can then immediately reposi­
tion the object where it is needed on the MacPaint window. 

Clear Blanks out the selected area or shapes on the window. 

Invert Changes any black parts of the selected area to white and any 
white parts to black. 

Fill Fills in the currently selected area with the pattern that you have 
chosen from the pattern palette. If the selection was made using the selec­
tion rectangle, the entire area is filled in. If the lasso was used to select one 
or more objects, just those objects are filled. 

The remaining four commands in the Edit menu work only in areas that 
have been selected with the selection rectangle. 

Trace Edges Traces the outline of any solid shapes lying within the 
selected rectangular region and then blanks out the solid portion of the 
shape. You can get some interesting results by repeatedly performing this 
command on a selected shape. 

Flip Horizontal Turns the selected area around (front to back) and 
shows the area from the back side. The result is a mirror image of the 
selected area. 
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Figure 5-2. The effects of Flip H o rizontal and Flip Vertical 

Flip Vertical Turns the selected area around (front to back) and over (top 
to bottom) so that the resulting shape is reversed and upside down. The 
screen shown in Figure 5-2 was created by using both Flip Horizontal and 
Flip Vertical to make mirror images of the word Mirror. 

Rotate Rotates the selected area 90 degrees counterclockwise. Four con­
secutive Rotates bring the area back to its original position. 

Goodies 

The commands in the Goodies menu a llow you to customize, fine-tune, or 
specially edit an image. The menu also includes commands for selecting 
brush styles, widths, and options. The Grid and Fatbits commands in this 
menu act like switches. You select them to turn them on and select them 
again to turn them off. 
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Grid Lays down an invisible grid of 52 by 30 lines on the MacPaint 
window. The lasso, selection rectangle, line, and all of the shape tools 
will then make use of beginning and ending points corresponding to the 
cross-points of the grid. This helps you create and position certain types 
of objects with better accuracy. 

Grid can be selectively turned on and off as you work with MacPainL 
This gives you the freedom of constraining one portion of a design to the 
grid while a llowing another portion to be placed freely. 

Fatbits Provides a close-up of a portion of the MacPaint window. With 
Fatbits you can use all of the graphics tools to fine-tune your designs. 
Notice the small rectangle in the upper-left corner of the Fatbits window 
in Figure 5-3. This window shows the normal, or "world," view of the 
close-up area. 

You leave Fatbits by either selecting Fatbits again from the Goodies menu 
or by clicking the mouse button with the cursor pointing into the world­
view rectangle. 

Figure 5-J. Fatbits screen 
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Show Page Displays the full MacPaint canvas (Figure S-4), although 
with grealiy reduced clarity (because the page is compressed into a small 
display area). 

You can reposition the window in another pan of the page by moving the 
cursor into the do tted rectangle, holding down the mouse button, and 
dragging the rectangle to the desired area. The entire page may be shifted 
by pressing the mouse button with the cursor outside of the dotted rectan­
gle and then dragging the page around the screen. 

You return to the normal MacPaint window by clicking the OK button or 
the Cancel button. Cancel causes MacPaint to disregard any positioning 
changes you made to the canvas or the window. 

Edit Pattern Allows you to customize the currently selected pattern from 
the pattern palette. A pa ttern consists of a block of 8 X 8 dots, each o f 
which can be individuall y turned on or off. 

You turn the dots on and off by pointing the cursor at the appropriate 
dots in the pattern box and clicking the mouse button. If you point and 

L ..•..... ·-··············--·····················-·············; 
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Figure 5-4. Displaying the entire canvas with Show Page 
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click on a dot that is off, it will be turned on, and vice versa. 

Brush Shape Provides the following selection of brush shapes for use 
with the brush tool: 

II e / " • • / ' 
• • / ' .. 

• [] , 
~ 

Select a brush shape by pointing at it with the cursor and clicking the 
mouse button. You can also change brush shapes by double-clicking on 
the brush in the tool palette. 

Brush Mirrors Lets you select a set of mirrors that will reflect the move­
ments of the brush tool. You can select from one to four mirrors to reflect 
along the vertical, horizontal, and diagonal axes. 

Introduction You can use this to review the functions of the tools in the 
tool palette. Figure 5-5 shows the screen you will see. Click the Cancel 
button to return to your original window. 

Short Cuts Displays a list of some of the shortcuts that can be used in 
MacPaint. (See the "Shortcuts" section later in this chapter). 

Font 

This menu allows you to select from a list of different character fonts. To 
place the text in the MacPaint window, select the text tool from the tool 
palette. You can choose from any of the following fonts. 



r 

-

Chicago Font 

Geneva Font 
New York Font 

t1onac o Font 

Venice Font 

:ton~on jfont 
Rthens Font 

Tm-ont o Font 
san !?ran ciSco I? on t 
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Los Ange les Font 
f <iJ ~ ~ ~ (Cairo Font) 

filled 
shapes 

curren t 
pattern 

+- no border 

line & border 

} 
wid ths, mt!ltiple 
copy spacmg 

patterns 
! ~------""------.. 

Figure 5·5. Introduction screen 
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FontSize 

This menu offers a variety of eight font sizes from which to choose: 9, 10, 12, 
14, 18, 24, 36, 48, and 72 point. Certain font sizes may work better with a 
particular font than others. Appendix B shows the fonts printed in several 
sizes. After you select a given font, the recommended sizes for that font are 
highlighted in the FontSize menu. 

Style 

This menu offers a variety of character styles to use with the text tool. The 
styles are fairly obvious from their names: 

Plain 

Bold 

Italic 

Underline 

Outline 

Shadow 

An example of the various styles is shown in Appendix B. 
The three align commands, Align Left, Align Middle, and Align Right, 

are used to determine how the text will be aligned on the screen. Align Left 
causes the text to be aligned along the left margin. Align Middle allows you 
to center the text. Align Right causes the text to line up along the right 
margin. 

SHORTCUTS FOR MACPAINT OPERATIONS 

A number of MacPaint operations have shortcuts. These fall into three cate­
gories: keystroke shortcuts, which use the OPTION or COMMAND key along 
with another key or tool; double-clicking; and special keystrokes, which 
assign certain commands directly to a key. Figure 5-6 is a summary of these 
shortcuts. 

The keystroke shortcuts are especially useful when you are touch-typing 
with the text tool. In this case, it is often faster to press a key than to take 
your hands off of the keyboard to work with the mouse. 

For example, to select Italic text, you can either use the mouse to pull 
down the Style menu and then select the Italic command, or you can hold 
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Figure 5-6. Summary of shortcuts 
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down the COMMAND key and press the 1 key. If you are already using the 
mouse, it is usually quicker to use it to make a selection, since you do not 
have to shift over to the keyboard. 

Double-dick shortcuts are invoked by pointing the cursor at the appro­
priate tool on the tool palette and quickly pressing the mouse button twice. 
For example, to erase the entire MacPaint window, point the cursor to the 
eraser tool and click the mouse button twice. Notice, however, that this 
clears only the current window, not the entire canvas. 

The special keystrokes allow you to enter a few of the MacPaint com­
mands from the keyboard. For example, you can perform the Undo com­
mand found in the Edit menu by pressing UNDO, the leftmost key on the top 
row of the keyboard. You can Clear a selected area or shape by pressing the 
CLEAR key, the rightmost key. 

The <and > keys work in conjunction with the COMMAND key to change 
the current character size. When used with both the SHIIT and COMMAND 

keys, the current font is changed instead. 
The remaining special keystrokes work in conjunction with the mouse 

and some of the MacPaint tools. The CONSTRAIN key allows you to restrict 
the box to drawing squares, the oval to drawing circles, and the line to 
drawing lines at 45- and 90-degree angles. The CONSTRAIN key also restricts 
the paint brush and the pencil to drawing horizontal and vertical lines. The 
COPY key works with the selection rectangle and the lasso to create identical 
copies of selected areas or shapes. The STRETCH key works with the selection 
rectangle to stretch or shrink the size of selected areas. If you hold down 
both the COPY and the STRETCH keys, you can make multiple copies of an 
object selected with either the lasso or the selection rectangle. 



C H A P T E R 

PATCHWORK 
PATTERNS 

S I X 

Some of the most intriguing and eye-catching art is based on geometric 
designs. A geometric design uses lines and simple shapes to form patterns 
that are then replicated and intermixed repeatedly. The results can be quite 
spectacular. 

Perhaps the most common examples of geometric designs are patchwork 
designs. The patchwork design is usually based on a central motif, or theme, 
which is then replicated numerous times to create the desired patchwork. For 
example, Figure 6-1 shows a patchwork design in which the motif consists 
of four squares of equal size, each formed by a different pattern. Throughout 
this chapter, the term patchwork will refer to patterns made up of geometric 
designs. 

MacPaint gives you the freedom to experiment with some fairly intricate 
patchwork designs. Using the techniques presented in this chapter, you will 
see how easy it is to create patchworks in a matter of minutes. The resulting 
designs are often quite surprising and attractive. 

SELECTING YOUR MACPAINT TOOLS 

The basic idea behind creating a patchwork is simple. You start with a sim­
ple building block like a square, divide the block into several parts, and 
place a different pattern in each. Then you make copies of the building 
block and piece each copy into the patchwork. 

83 
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Figure 6-1. A central motif replicated to form a patchwork 
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MacPaint has specific tools to do each of the steps required to build a 
patchwork. The box or oval tool can be used to set up the building block. 
The line tool and the paint bucket can be used to divide and embellish the 
block. The selection rectangle and the lasso are used to make copies of a 
block and position them on the screen. 
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Two special options make the creation of a patchwork both easier and 
more precise. These options are the constrained drawing operations and the 
grid feature. 

CONSTRAINED LINES, BOXES, 
AND OVALS 

A patchwork design works best when it is symmetrical. For example, it is 
generally more effective to use a true square or circle as a building block 
rather than a random rectangle or oval. Likewise, you may want to use lines 
that lie along the horizontal or vertical axis or at 45-degree diagonals. 

To draw diagonals, MacPaint offers the option of constraining lines along 
45- or 90-degree angles. It also allows you to constrain the box tool to create 
true squares and the oval tool to make perfect circles. 

To constrain the operation of a tool, begin by selecting the desired tool 
from MacPaint's tool palette. Move the cursor to the desired starting point 
on the window. Now constrain the operation by holding down the SHIFT 

key. Depress the mouse button while you move the cursor around the win­
dow. Figure 6-2 is an example of the oval tool constrained to draw a perfect 
circle. 

USING THE INVISIBLE GRID 

When you draw the basic building-block element for a patchwork, it is usu­
ally best to set up the building block so it can easily be divided into equal 
parts. For example, you might want to divide a square in half or a circle in 
quarters in order to put a different pattern in each section. 

If you draw a random square on the MacPaint screen and attempt to 
divide it into an equal number of sections by ~~eyeballing" it, your chances 
of success will be pretty slim. While MacPaint will not automatically divide 
an object into equal parts, it does contain a feature that lets you draw an 
object so it can be divided easily. This feature is called the Grid command.· 

If you pull down the Goodies menu, you will see a command called Grid. 
If you select this command, you may not notice a change in how MacPaint 
operates. However, if you select the line or another tool, you will see that the 
cursor seems to jump and jerk more as you move it about the window. A 
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v_ll)lmR -· 
Figure 6-2. Circle created with a constrained oval 

., 

liule testing will show that you are now limited in where you can stan and 
stop a drawing operation. 

When the Grid command is selected, MacPaint places an invisible grid of 
lines onto the window. After this, when drawing with LOols like the line, 
box, and oval you are restricted to positions in the MacPaint window where 
these invisible grid lines intersect. 

To gel a better feel for what Grid does, clear the MacPaint window. (This 
can be done by moving the cursor to the eraser in the tool paleue and 
double-clicking the mouse button.) Check to see that the grid is turned on 
by pulling down the Goodies menu and making sure there is a checkmark 
on the left side of the Grid command. If not, select the Grid command to 
turn on the grid. 

Now select the paint bucket from the tool paleue. Move down to the pat­
tern pa lette and click on the larger of the two square grid designs. Move the 
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Figure 6-J. Grid pattern 

cursor out to the window and click the mouse buuon. This will fill the 
screen as shown in Figure 6-3. 

It just so happens that this grid is the same exact size as the invisible one 
used by the Grid command. In fact, this visible grid is p laced in the same 
screen position as the invisible grid. 

Choose the filled box tool from the tool palette. Move LO the pauern 
paleue and select the solid black pauern. Now move to the MacPaint win­
dow. Press and hold down the mouse button while you drag the cursor 
around the window. You should see something like the object shown in 
Figure 6-4. 

Notice that no mauer where you move, the resulting box falls exactly 
along the grid coordinates. Turn off the grid by pulling down the Goodies 
menu and selecting the Grid command again (this works like a light switch, 
turning the grid on and off). Return to the window and draw some more 
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Figure 6-4. Using a grid to place an object 

filled boxes. The boxes fa ll anywhere on the window. T he filled box tool is 
no longer restricted to the grid lines. In fact, it is difficult to draw a box that 
lies exactly a long the grid. 

Try this now. Choose the selection rectang le with the grid turned off. 
Move to the screen and try to draw a selecting rectangle around one o f the 
solid boxes that you drew with the grid on. Next, turn the grid back on and 
try selecting the box again. Notice how much easier it is to draw and select 
boxes with the grid on. 

When the grid is turned on , many MacPaint operations are constra ined to 
the invisible grid lines. Remember tha t you saw the grid lines in the pre­
vious exam ple only because you painted the window with the grid pattern 
from the pattern pa lette. You will normally not see the grid lines when you 
use the Grid command. 
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Normally, the MacPaint window has a resolution of 416 horizontal posi­
tions by 240 vertical positions. When you use the Grid command, the resolu­
tion is restricted to 52 horizontal by 30 vertical positions. What this means is 

• You can create measured objects with the Grid command. Using the 
constrained box (to draw a square) with the Grid command on, you can 
count the number of "jumps" that the cursor makes as you carefully 
draw a square. If you count four such jumps, you know that the square 
is four sections wide by four tall and that it is thus divisible into halves 
or quarters. If you count six jumps of the cursor, you will have a square 
that can be divided into halves, thirds, or sixths. 

• You can use the selection rectangle to exactly select any square or box 
that was designed with the Grid command on. This is important 
because any error in selecting a patchwork element will be replicated 
many times over. 

• You can exactly position elements that have been selected with either 
the lasso or the selection rectangle. Just as the capability of exactly 
selecting a patchwork element is important, if you could not easily 
position each copy of the element, creating an entire patchwork would 
be quite tedious. 

The Grid command makes creating patchwork fairly easy and precise. 
Certain difficulties involved in creating exotic patchworks still remain, but 
creating rudimentary patchwork designs with MacPaint is a straightforward 
task. 

PROJECT 

DESIGNING YOUR 
FIRST PATCHWORK 

Let's work through a simple patchwork design. You will use the Grid com­
mand and the constrain option to design, select, and position the elements 
of your patchwork. 
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Step 1: Start off with a clean slate. Clear the MacPaint window if any­
thing is on it. Make sure that the Grid command is turned on. 
Select the box tool from the tool palette and move the cursor onto 
the window. It is not important where on the window you begin. 

Step 2: Hold down the SHIFT key (to constrain the box tool to draw 
squares), and press and hold down the mouse button. Slowly 
move the cursor diagonally (any direction is okay). As you move 
the cursor, count the number of jumps it makes. After four 
jumps, you should have a 4 X 4 unit square (approximately half 
an inch square). Release the mouse button. If the mouse slips as 
you release the button, and you make a square of the wrong size, 
select the Undo command from the Edit menu and try again. 

Step 3: Select the line tool and draw two diagonal lines connecting the 
opposing corners of the square. Select the paint bucket tool from 
the tool palette. Using four different patterns from the pattern 
palette, paint each of the four parts of the square. For example: 

Step 4: This will be your basic building block for the patchwork. Get the 
selection rectangle and precisely select the complete square. You 
do this by moving the cursor to one corner of the square and then 
holding down the mouse button while you drag the cursor to the 
opposite corner of the square. Releasing the mouse button selects 
the square. 

Step 5: Make a copy of the selected square and position it next to the 
original. Do this by moving the cursor inside of the selected area 
until the cursor becomes an arrow. Hold down the OPTION key 
and then press and hold down the mouse button to make the 
copy. Drag the copy beside the original and release the mouse 
button. 

Make another copy of the selected square (again, simply by press­
ing the OPTION key and the mouse button) and position it into 
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the developing patchwork pauern. 

At some point this task of building the patchwork one element at 
a time may get tiresome. No problem. Use the selection rectangle 
to select several of the elements at once and continue copying and 
moving with this block. The finished patchwork is shown in 
Figure 6-5. 

Figure 6-5. The completed patchwork design 
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In a matter of moments you have built a fairly interesting and intricate 
patchwork design. Drawing a design like this with pencil, paper, and ruler 
would take hours of labor. The ease with which MacPaint can design 
patchwork greatly encourages experimentation since it is not too painful to 
discard the work of a few minutes. 

As you build different patchwork designs, you will notice that MacPaint 
will not let you position a selected object beyond the window border. You 
are restricted to moving selected elements only within the boundary of the 
current window. If you want to fill the whole MacPaint page with a patch­
work, you will need to build as large a patchwork as possible in the window. 
First use the selection rectangle to select the entire patchwork; then use the 
Copy command in the Edit menu to place a copy of the patchwork in the 
system Clipboard. After this, you can use the grabber to move the page 
around in the MacPaint window and the Paste command to paste a copy of 
the patchwork into the blank parts of the page. 

If you try to join two patchworks together, you may have a problem lining 
them up properly if the Grid command is still on. Any time you use the 
grabber to move the window around, you may lose the ,positioning of the 
grid system. In other words, if you save a copy of the patchwork to the 
Clipboard, use the grabber to move the page about, and paste the Clipboard 
into a new portion of the page, the old and new parts of the patchwork may 
not align properly with the Grid command on. In this case you will have to 
turn the Grid command off and position the two patchworks as accurately 
as you can. 

One of the fun things about patchworks is the surprising effect that seem­
ingly small changes to the basic motif can make on the final design. As an 
experiment, let's create a different patchwork design using a slight variation 
of the building block from the previous example. 

Select the basic block with the selection rectangle. Make a copy of this 
selected block by using the OPTION key. Select the Rotate command twice 
from the Edit menu to turn this block first 90 degrees and then 180 degrees. 
join the two blocks and use them as the new building block, except stagger 
the copies as you build the patchwork. 
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Figure 6-6. Patchwork design modified with Rotate 

T he result of combining the origina l square with a ro tated copy o f that 
square is a very different patchwork, as you can see from Figure 6-6. 

Now try ano ther examp le. Use the same two building blocks from the last 
examp le, but now use the Fatbits command in the Goodies mode. (Fatbits 
will be discussed in the next section.) Select the eraser and carefully erase the 
lines surrounding the squares. T he resulting patchwork (Figure 6-7) is again 
markedly different even though the change to the building block was minor. 

OF HEXAGONS AND FATBITS 

Patchwork design is by no means limited to the use of squares as the basic 
building element. In fact, the only genera l rule is to use symmetrical build­
ing blocks, and even this rule can be ignored. Sh apes often found in patch­
work designs include circles (easily created with the constrained oval tool), 
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Figu re 6-7. Patchwork design modified with Fatbits 

various polygons (pentagons, hexagons, octagons, and so forth), stars (with 
five, six, eight or more poims), and many variants and combinatio ns of these 
shapes. 

In this next example, you will see how MacPaint 's tools can help you 
create a special symmetrical shape, the hexagon, that is not o ffered as a 
standard shape. T he process of desig ning the fi rst hexagon for a patchwork 
is somewhat tedious, but once the hexagon itself is designed, using it to 
build a patchwork is no more difficult than using a square. Similar stra te­
gies can be used to make many other symmetrical shapes. 

Designing complex shapes makes use o f the Fatbits command. Fatbits is a 
"zooming" feature that lets you edit MacPaint shapes wi th extremely fine 
precision. It is like using a microscope to examine a picture in great detail 
and being able to make minute changes. All of the MacPaint tools work 
with Fatbits. For example, you can use the eraser to carefully remove specific 
parts of a drawing, or you can use the pencil to make fine changes. You can 
select Fatbits from the Goodies menu or, alternatively, by moving the cursor 
to the pencil in the tool palette and double-clicking the mouse button. 
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PROJECT 

DESIGNING A HEXAGON 

A hexagon is a symmetrical six-sided figure with six sides of equal length. It 
is not obvious at first how you can draw such a shape using MacPaint, since 
no hexagon shape tool is available. Let's work through a step-by-step 
method for creating hexagons: 

Step I: Start off with a clean MacPaint window. Turn on the grid in the 
Goodies menu and select the box tool from the tool palette. 

Step 2: Using the SHIFT key to constrain the box to draw only true 
squares, draw an 8 X 8 grid (slightly less than an inch in size). 

Step 3: Select the oval tool. Move the cursor to one corner of the square 
and, pressing the SHIFT key to constrain the oval to a circle, draw 
a circle that fits exactly within the square. At this point your 
figure should look like this: 

D 
Step 4: Find the halfway point of the left side of the box. This is four 

sections up from the lower-left corner. Make a second and third 
constrained circle upward and downward from this point to fit 
the box as shown here: 
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The four points where the two new circles intersect the first circle 
are four of the six corners of the hexagon. The points where the 
first circle intersects the top and bottom of the square are the 
remaining two corners. The exact center of the hexagon is the 
point where the two new circles meet. 

The following illustration shows how the hexagon actually fits 
into this jumble of circles and squares. This is for demonstration 
purposes, so do not try to draw your hexagon yet. 

Step 5: The three circles and the square on the screen are used only to 
help you locate the six corners of the hexagon. You now need to 

erase everything except for these corner points and the center 
point. Select Fatbits from the Goodies menu. Use the grabber to 
position the Fatbits display so you can see one or more of the 
hexagon's corners. For example, in the following illustration you 
see an intersection of two circles as well as the intersection of the 
circle and square. 
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untitled 
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Select the eraser from the LOol palette. Carefully erase all of the 
dots in a ll three circles and the square except where the described 
corners and the center point of the hexagon lie. You will need to 
use the grabber to reposition the Fatbi ts window as you erase 
these dots. You should be left with a screen containing only seven 
dots, the six hexagon corners and the cen ter dot. 

Step 6: Select the line tool and connect the dots of the hexagon. To do 
this, you wi ll need to turn o ff the grid. If you have trouble con­
necting the dots, use the Fatbits command to find two dots and 
connect them. 

Draw lines connecting the upper-left and -right corners of the 
hexagon to the center dot. Then draw another line to connect the 
center dot to the bo ttom corner. T his divides the hexagon in to 
equal thirds and is used quite often in patchwork designs. The 
final screen will look like this: 
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Drawing a true hexagon is a rather involved task. It is obviously error­
prone and time-consuming. But the rewards are now in sight. 

Before doing anything to this hexagon, you migh t wish to save it, either 
as a MacPaint file or in the system Scrapbook. That way you will not have 
to recreate the hexagon each time you want to try a new patchwork design. 

The next step, building a patchwork with hexagons, is not much different 
from building a patchwork with squares. You can fill in the three parts of 
the hexagon with selected patterns and build the patchwork by replicating 
this element. Or you can build the patchwork with blank hexagons and then 
fill it in with a variety of patterns once the main structure is complete. 

Use the lasso to select the hexagon and start p lacing copies into a patch­
work design. In the example shown in Figure 6-8, the patchwork structure 
was built with blank hexagons. Then the paint bucket was used to selec­
tively put patterns into the patchwork. 

The design in Figure 6-8 is known as " tumbling blocks" because it can 
appear to be a stack of blocks rather than an assortment of hexagons. To get 
the right effect, you should place light, medium, and dark patterns into the 

Figure 6-8. Patchwork created from a hexagon 
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Figure 6-9. Three patchworks created with MacPaint 
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three different parts of each hexagon. In the example in Figure 6-8, a light 
pattern was always placed in the top third of the hexagon, a medium pattern 
in the right third, and a dark pattern in the left third. 

These examples only touch the surface of possible patchwork designs. 
Many other types of building blocks can be used to create an infinite variety 
of patchwork designs with MacPaint. 

The hardest part of creating a patchwork with MacPaint is the design of 
the building block. This may be a time-consuming task if you are using a 
complex block. But once the block is done, the patchwork goes together 
rapidly. 

Before leaving the subject of patchworks, take a look at the three patch­
work designs shown in Figure 6-9. None of these designs took more than a 
few minutes to create. You might see if you can determine what basic build­
ing blocks were used to make these designs. 



P A R T F 0 U R 

Visual aids, such as drawings and pictures, 
formulas, pie charts, and bar graphs, add to 

the impact of the written word. With the Apple 
Macintosh you can combine the graphics ob­

jects created in MacPaint with text produced by 
Mac Write to enhance the documents you produce. 

In Part Four you will see how the Clipboard 
and Scrapbook are used to transfer graphics objects 



from MacPaint to MacWrite. Once you become familiar with the use 
of these two accessories, you will have no problem in efficiently blend­
ing visual aids with text. Designing a letterhead is one practical 
example of combining text and graphics, and in Chapter 8 you will 
get a chance to design a few of your own. After learning the mechan­
ics of combining Mac Write and MacPaint, you will be ready to begin 
experimenting with new ways of combining words and art. 



C H A P T E R S E V E N 

USING 
THE MACINTOSH CLIPBOARD 

AND SCRAPBOOK 

Two basic tools allow you to integrate Macintosh applications such as 
MacWrite and MacPaint. These are the Clipboard and the Scrapbook. You 
can usually choose either tool to transfer text and graphics from one appli­
cation to another. As discussed in this chapter, you will favor one over the 
other, depending on your circumstances. 

Although MacPaint and MacWrite are singled out in this chapter, the 
Clipboard and the Scrapbook are generic tools available to any Macintosh 
applications program. Thus, the techniques described here should be appli­
cable to a variety of Macintosh applications. 

USING THE CLIPBOARD 

The Clipboard is capable of temporarily holding text and graphics. For the 
sake of conciseness, this chapter refers to anything stored on the Clipboard 
as an object. You can move objects on and off the Clipboard at will. 

An object must be selected before it can be placed on the Clipboard. To 
select text with Mac Write, place the cursor at the start of the desired text and 
click the mouse button once; then move the cursor to the end of the desired 
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text, hold down the SHIFT key, and click the mouse buuon again. The 
selected text will be inverted (white characters on a black background). 

To select a portion of a MacPaint screen for storage on the Clipboard, you 
can use either the lasso or the selection rectangle. With the lasso you draw a 
"rope" around the desired area. Any graphics shapes within that area will be 
selected. With the selection rectangle you set up a rectangle around the area 
to be selected. Note that the selection rectangle selects an entire area, while 
the lasso selects objects within an area. 

Once the desired object is selected, you use either the Cut or the Copy 
command in the Edit menu to place the object onto the Clipboard. The Cut 
command removes the selected object from your application and places it 
onto the Clipboard. Copy makes a copy of the object and places it on the 
Clipboard without changing the object in your application. Figure 7-1 
shows a Cut operation in MacWrite. Note that the selected text is inverted. 

,. 
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Copy ~ 
Paste 

Sh Cl
. b d on your proposed agenda for the Finan<e 

ow IP oar k . 

1. Moving Date: Let"s wait av.lllile. D!scussing the movmg date 
seems premature, s1nce there are so many unl~nowns. 

l ·m concern~d about John g1vmg the 
-chmcal presentation He 's been out lately: and I really thml~ 
rani~ lias a better handle on the (Urrent status of manufactunng 
evelopm.;onts 

3- Party : A mental health par ty fr>r Fmance sounds great . Since 
there won't be much d iscussion, h~<lve it off the agenda_ Call Tim to 
help set it up_ Keep the costs down_ 

Figure 7-1. The Cul command in. MacWrile 
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Once an object is on the Clipboard, you can put copies of that object into 
different Macintosh applications programs by selecting the Paste command 
in the Edit menu. If you are placing the object into a MacWrite document, 
the object will be added at the insertion point. Objects transferred from the 
Clipboard into MacPaint will simply appear in the middle of the window, 
selected and ready to be positioned. 

When you use the Paste command, the contents of the Clipboard are riot 
changed. Rather, a copy of the object on the Clipboard is pasted into the 
application. However, when you Cut or Copy another object, the previous 
contents of the Clipboard are discarded. 

You are free to open and dose different Macintosh applications without 
losing the contents of the Clipboard. As long as you do not turn off the 
power to the system or perform any subsequent Cut or Copy operations, the 
contents of the Clipboard will remain intact. 

You can use the Clipboard in a number of ways, such as: 

• Cutting a portion of text (for example, a paragraph) out of a MacWrite 
document and moving it to a different position in the same document. 

• Copying a portion of text (for example, a phrase) and placing it in one 
or more places throughout the document. 

• Moving a copy of some text into a different Mac Write document, either 
on the same or a different disk. 

• Making a copy of a MacPaint object to be placed in a different part of 
the canvas. 

• Setting aside a copy of a MacPaint object so you can experiment with 
the original. If you then want to return to the unmodified object, you 
can dear the window and Paste the copy from the Clipboard back onto 
the screen. 

• Moving text from a MacWrite document onto a MacPaint canvas. 

• Moving a MacPaint graphics object into a MacWrite document. 

• Moving the contents of any Macintosh application to another 
application. 

The real power of the Clipboard is its consistent operation regardless of 
the application you are running. Whenever you need to move a portion of 
text or a graphic from one place to another, the Clipboard provides you with 
a standard and easy-to-use method for doing this. 
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USING THE SCRAPBOOK 

The Macintosh Scrapbook is an extension of the Clipboard. You can think 
of the Scrapbook as a place to store Clipboard objects more permanently. 
Scrapbook objects are accessible by the Clipboard at all times. Objects 
remain in the Scrapbook even after you turn off your Macintosh. 

The Scrapbook is a Macintosh desktop accessory (review Chapter 2 for 
more on desktop accessories). You can store any number of objects (text, 
graphics, or combinations of text and graphics) in the Scrapbook. Anything 
you can place onto the Clipboard you can permanently store in the Scrap­
book. In fact, the only way to put objects into the Scrapbook and later get 
them back is with the Clipboard. 

Move the cursor on your Macintosh screen over to the picture of the apple 
in the upper-left corner. Pull down the menu of desktop accessories. Move 
the cursor down to select the Scrapbook. You should see something like the 
screen shown in Figure 7-2 (the picture shown on the Scrapbook page may 
be different). 

The Scrapbook contains a window that displays the current Scrapbook 
page, a scroll bar for scrolling through the different pages of the Scrapbook, 
a page number in the lower-left corner, and an identification of the object in 
the lower-right corner ("PICT" for MacPaint pictures, "MWRT, TEXT" for 
MacWrite text, and so forth). You can browse through the pages of the 
Scrapbook by pointing the cursor at the arrows on the right and left sides of 
the scroll bar and clicking the mouse button. You can also position the 
cursor on either side of the small box and click the mouse button to move a 
page at a time, or you can drag the small box along the scroll bar to jump to 
a particular place in the Scrapbook. 

To add an object to the Scrapbook, you must first place it on the Clip­
board as described in the previous section. Next, open the Scrapbook acces­
sory. Pull down the Edit menu and select the Paste command. This copies 
the contents of the Clipboard into the currently active window, which 
happens to be the Scrapbook. 

When the Macintosh realizes that you are pasting an object from the 
Clipboard into the Scrapbook window, it automatically places the object on 
a new page in the Scrapbook. The Scrapbook will thus grow in size as you 
place more and more objects in it. The Macintosh stores the Scrapbook on 
the system disk, so the only limit on adding to the Scrapbook is the capacity 
of the disk. 

just as you used the Paste command to move an object from the Clip­
board into the Scrapbook, you use the Copy command to retrieve an object 
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Figure 7-2. Opening the Scrapbook window 
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from the Scrapbook and transfer it onto the Clipboard. Scroll through the 
Scrapbook until you see the object you want. Select the Copy command 
from the Edit menu to place a copy of the object onto the Clipboard. 

Use the Cut command to move an object onto the Clipboard and delete 
the corresponding page from the Scrapbook. If your Scrapbook gets unman­
ageably large and you want to discard some o f the objects, use the Cut com­
mand to remove the Scrapbook pages of your choice. 

CHOOSING BETWEEN THE CLIPBOARD 
AND THE SCRAPBOOK 

Once you understand how the Clipboard and Scrapbook work, deciding 
which to use for transferring objects within an application and between dif­
ferent applications is usually easy. 
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The Clipboard provides the fastest mechanism for moving a single object. 
However, because it provides only temporary storage, you must be careful 
not to accidentally use another Cut or Copy command to replace an object 
that you want to save. 

The Scrapbook is an extension of the Clipboard that allows you to build a 
library of objects for more permanent storage. If you want to move more 
than one object between applications (suppose you want to use MacPaint to 
draw four different graphics designs and then move them all into a Mac­
Write document), you should use the Scrapbook to store each of them. Then 
you can exit the first application, start up the second, and transfer the 
objects from the Scrapbook through the Clipboard into your application. · 

Note that if you are transferring an object from an application on one disk 
to an application on another disk, you must copy the object to be transferred 
onto the Clipboard prior to ejecting the disk. Since the Scrapbook is stored 
on disk, two different disks could contain two separate Scrapbook files. 

If you need a copy of the Scrapbook on another disk, you can copy the 
Scrapbook file (usually found in the system folder) from one disk to another. 

DIFFERENCES BETWEEN MACWRITE 
AND MACPAINT OBJECTS 

Let's now look briefly at the different ways that objects are treated in Mac­
Paint and MacWrite. These differences can have an impact on how you 
transfer objects between applications. 

MacWrite is a word processor. It looks at what you type at the keyboard as 
text characters. Each character of a MacWrite document can have its own 
font, size, and style, independent of the other characters around it. However, 
characters must be displayed as rows of text; so the largest character in a 
particular row will determine the height of that row. Different rows of text 
in a MacWrite document thus may have different heights. 

MacPaint is a graphics processor. Everything in MacPaint is oriented to 
creating, displaying, and editing graphics objects. Even though MacPaint 
has a "text" mode with which you can enter text in many various fonts, 
sizes, and shapes, once you are done entering and editing the text, MacPaint 
ceases to treat the characters as text. Instead, it simply views the text as 
graphics shapes on the canvas. 

When an object is created with MacPaint and then transferred to 
MacWrite with the techniques discussed in this chapter, MacWrite treats the 
object strictly as a graphics object. No attempt is made to determine whether 
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or not that object has text within it or whether it contains a number of 
separate objects. MacWrite sees it as a single graphics structure. 

This means that MacWrite will be unable to edit any "text" that you have 
entered with MacPaint. Even if you create a MacPaint object composed 
entirely of text, MacWrite will treat the object as a graphics object. If you 
later find that you must edit part of this object, you will have to transfer it 
back to MacPaint and use MacPaint's graphics-editing features. 

Let's look at a transfer in the other direction. When you move text from 
MacWrite (using either the Clipboard or the Scrapbook) to MacPaint, Mac­
Paint accepts the text into its graphics page. However, as soon as the text is 
moved into MacPaint, it loses its identification as text. Instead, it simply 
becomes a graphics object. 

Consider the following: Using MacWrite, type in some text. Select the text 
and copy it onto the Clipboard. Leave MacWrite and start up MacPaint. 
Paste the text into MacPaint. At this point, the text entered with MacWrite 
is now a graphics object. Even if you were to copy the text back onto the 
Clipboard and paste it into a MacWrite document, you could not edit it as 
text. 

In other words, be aware that once you transfer text to a MacPaint docu­
ment, you can only use MacPaint's graphics tools (the eraser, the lasso, the 
text tool, and so forth) to edit the characters. This can be tedious and may 
not result in a good match. Similarly, you cannot edit text created with 
MacPaint once you transfer the text to a MacWrite document. Keeping these 
factors in mind, you can freely combine MacPaint graphics objects with 
MacWrite text objects for wonderful results. 



C H A P T E R E I G H T 

CREATING 
A LETTERHEAD 

This chapter demonstrates a complete application that integrates MacPaint 
graphics with Mac Write text -creating a letterhead. Using the Macintosh, 
you will find it fairly easy to design attractive custom letterheads. 

Letterheads identify the name and address of a business or individual at 
the top of a letter. A company logo or motto might also be included in a 
letterhead. Being able to create a custom letterhead can often be useful. For 
example, you might like to have three or four custom letterheads for differ­
ent aspects of your business or hobby. 

The ability of MacPaint and MacWrite to combine graphics and text into 
single documents gives you a prime opportunity to create an endless variety 
of unique letterheads. In addition, as you work through the example in this 
chapter, you will learn the mechanics of transferring graphics from 
MacPaint to MacWrite. 

A REVIEW OF MACPAINT 
OPERATIONS 

Let's take a moment to review some of the operations that you will use in 
designing a letterhead. 

111 
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• To transfer objects from the Scrapbook to MacPaint: With MacPaint 
running, point the cursor to the apple in the upper-left corner of the 
MacPaint screen. Press the mouse button to pull down the desk acces­
sory menu. Move the cursor down the menu and select the Scrapbook. 

Next, scroll through the contents of the Scrapbook by clicking the 
arrows at the lower-right and -left sides of the Scrapbook. When you 
locate the desired object, pull down the Edit menu and select the Copy 
command. This copies the object from the Scrapbook to the Clipboard. 

Close the Scrapbook by clicking the close box in the upper-left corner 
of the window. Pull down the Edit menu and select the Paste command 
to copy the contents of the Clipboard onto the MacPaint window. 

• To move selected areas or shapes on the screen: Select an object or a 
region in the MacPaint window with either the lasso or the selection 
rectangle. Move the cursor within the selected region until it becomes 
an arrow. Press and hold down the mouse button as you drag the area 
around the screen to position it. 

• To make a copy of a selected area: Select and then drag the object as in 
the previous operation, but hold down the OPTION key before you press 
the mouse button. This creates a copy of the selected area. You can then 
position the copy of the selected area on the screen. 

• To constrain the· movement of a selected area: Constrained movement 
of a selected area permits the area to be moved only in a horizontal or 
vertical direction. Select the area to move; then hold down the SHIIT 

key before pressing the mouse button and dragging the object. For 
example, if you want to make a copy of an area and then move it hori­
zontally, press and hold the SHIIT key, then the OPTION key, then the 
mouse button, and drag the copy horizontally. 

• To flip a selected region horizontally or vertically: Select the area with 
the selection rectangle. Move the area to the desired position. Pull down 
the Edit menu and select the Flip Horizontal or Flip Vertical command. 



PROJECT 

LETTERHEAD DESIGN 
WITH MACPAINT 

Qeating a Letterhead I II3 

Now let's begin creating a letterhead with MacPaint. The completed design 
is shown in Figure 8-1. 

While the step-by-step procedure can vary, this example demonstrates the 
general approach to making a custom letterhead. You will also see some 
common techniques that can be used in many other applications of 
Mac Paint. 

Step 1: Start up MacPaint. 

Step 2: The Macintosh System Disk includes a few objects in the Scrap­
book. Open the Scrapbook and locate the corner object. 

~~ N~ 
{Cfl)lilJ,[f)(!) (J@~ (Cfl)lilJ,[f)r!lllllJ? 

123 illlaplt i)ttttt 
~unny ctttty, cttaltfotnia 45G7S 

(123) 45G-7S90 

Figure 8-1. Completed letterhead 
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Copy this object onto the MacPaint page. If the Scrapbook does 
not contain the corner object, skip to the next step. 

Step 3: If your Scrapbook does not contain the corner object, draw your 
own. A Fatbits closeup of the corner object follows. You can 
create this on your own by choosing the Fatbits command from 
the Goodies menu and using the pencil tool to do a freehand 
sketch. 
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Step 4: At this point you should have a copy of the corner object in the 
center of your screen. Using the selection rectangle, select the 
corner object. Move the corner object into the upper-left corner of 
the window. 

You will be placing four corners to form a rectangle. Do not 
worry too much about their placement right now since you will 
not know exactly how large you want the rectangle until the text 
is set up to go inside. You will later enlarge or shrink the rectan­
gle to fit your company name and address. 

With the corner object still selected, make a constrained copy and 
move it to the right side of the window. (Remember, press and 
hold the SHIFT and OPTION keys before pressing the mouse 
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button to get a constrained copy of a selected object.) Your screen 
should look something like this: 

_o untitled 

·--- --- ... 
~ .. ,~ 1 

:~~~: 
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I I 

I_ -- -~- - .J 

Select the Flip Horizontal command from the Edit menu to rotate 
this corner in the appropriate direction. 

Next, using the selection rectangle again, select bo th of the 
corners on the screen. Make a constrained copy of these corners 
(SHIFT-OPTION keys) and move the copy down until it clears the 
top two corners. The screen should look like this: 

0 untitled 

·---------------------------------------. 
: ~c;r ~~ : 

i ~ ~ i 1------ ---~------ -- -- - ------ --------- - - - -
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Use the Flip Vertical command from the Edit menu to flip the 
two bottom corners to the correct position. 

Step 5: You now have the four corners of the rectangle. The next step is 
to select the line tool and, using appropriate line widths, to con­
nect the corners of the rectangle. If you use the SHIFT key to con­
strain the line, drawing true vertical and horizontal connecting 
lines will be easier. 

When you go to select the proper line width for the outer line, 
you will notice that MacPaint does not have a line width that 
exactly matches the one you need. However, you can place two 
thinner lines side by side (overlapping if necessary) to produce a 
single line of the proper width. 

Step 6: You are now ready to type the text of the letterhead. If you wish, 
replace the text in the example with your own company name 
and address. 

Begin by selecting the text tool from the tool palette. Pull down 
the Style menu and choose Align Middle to center the name and 
address of the company as you type it in. Move the cursor to the 
MacPaint window and click the mouse button in the center of a 
dear area of the screen. The center of the company name will be 
here. If you do not have enough room on the MacPaint window 
for both the rectangle and the text, use the grabber to reposition 
the page. 

The company name in this example uses the Bold, Italic, and 
Shadow selections in the Style menu; the characters are 24 point 
New York. Type the company name using these selections. 

After typing in the company name, press the ENTER key to spec­
ify that the remainder of the text will be in a different style, size, 
and font. Press the RETURN key to move to the next line and 
choose Plain from the Style menu, 18 point letters from the Font­
Size menu, and the London font from the Font menu. 
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Now type the street address of the company. Press RETURN and 
add the city, state, and ZIP code. Press RETURN one more time 
and type the company phone number. The resulting display will 
look something like this: 

untitled 

(b@fil}fj){!} fl@tr cb@!illfj)lll!ilJY 
t23 ;ililapl~ ~tt~~t 

~unuy C!ttty, C!taltfot·uta 45678 
(tZ3) 456-7890 

Step 7: The rectangle in this example is obviously too small to enclose 
the company name and address. Thanks to MacPaint, stretching 
out the rectangle is a simple matter. 

One option is to use the selection rectang le, which can stretch or 
shrink a selected area. However, this tool will often distort the 
shapes within the area. You might try a second method instead. 
Notice that you really do not want to stretch the corners of the 
rectangle; you just need to change the lengths of the lines joining 
the corners. So you can use either the lasso or the selection rect­
angle to select half of the rectangle and break the rectangle in 
two. The halves are separated and then the broken lines can be 
connected with the paint brush to make a new and larger rectan-

, gle. T he following screen demonstrates this technique. 
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Be sure to constrain the selection tools so that the rectangle stays 
properly aligned. It is importan t that you a lways move the 
corners in pairs, rather than one at a time, in order to maintain 
alignment of all the corners. 

When the rectangle appears to be just a little larger than the area 
of the text, use the lasso tool to select the text. If the text is on a different 
part o f the page, use the Cut command in the Edit menu to place 
the text in to the system Clipboard. Then reposition the page so 
you can see the letterhead box in the window, and paste the text 
into the box. 

If the box is too big, you can use the lasso tool, selecting two 
corners at a time, to shrink the rectangle to fit perfectly around 
the name and address. The resulting letterhead is the one shown 
in Figure 8- 1. 

Step 8: Save the letterhead o n disk. Simply choose the Save As command 
from the File menu and save the letterhead u nder the name of 
your choice. 

You can a lso use the Scra pbook as the permanent storage loca­
tion for this and any other letterheads you might design. This 
will a llow you to store the letterhead until you are ready to use it. 
If you choose to use the Scrapbook to store the letterhead, just 
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Distributors of the Apple 
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Computer Company 
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Figure 8-2. Letterheads created with MacPaint 

copy the letterhead directly from MacPaint into the system Clip­
board and then into the Scrapbook. In the following sections, 
you will see how to integrate the letterhead with your letters. 

Figure 8-2 contains several ideas for other letterheads that you can easily 
create with MacPaint. These letterheads were all designed with standard 
MacPaint tools-particularly text, box, rounded box. paint bucket. and line. 

If you have a company logo. mascot. motto, or any other special symbol of 
identification, you may want to include it in your letterhead. 
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INTEGRATING THE LETTERHEAD 
INTO MACWRITE 

Once you have saved the letterhead, there are several ways you can integrate 
it into a MacWrite document. 

First, you can set up the lenerhead as part of the header in a MacWrite 
document. Recall from Chapter 3 that MacWrite a llows you to set up a 
header that includes the date, time of day, and page number. You can also 
add text or graphics of your own design to the header. 

Placing the letterhead in the header is a logical choice with onl y one 
potential disadvantage: MacWrite places a copy of the header at the top of 
every page in a document. So if you have multipage letters, each page will 
be printed out with the lenerhead. 

To avoid this problem, the letterhead can simply be placed at the start of 
the letter. This ensures that it will only appear once. However, if you use the 
header (for example, to insert the current date at the top of the page), you 
also need to select the Title Page option in the Format menu to prevent the 
header from appearing before the letterhead. 

Let's set up a header to include the letterhead. You should sti ll have a 
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Figure 8-J. Moving the letterhead to the header 



Creating a Letterhead I 121 

copy of the letterhead on the Clipboard. If not, use the Copy command to 

transfer a copy from either the Scrapbook or from the file where the letter­
head is stored. Then you can start up MacWrite to create the new document. 
From MacWrite, pull down the Format menu and choose the Open Header 
command. This will open up the header window on your MacWrite screen. 

Select the Paste command from the Edit menu to copy the letterhead from 
the Clipboard into the header as shown in Figure 8-3. 

You can now select the letterhead. To select a MacPaint object that is in 
MacWrite, just move the cursor within the object and click the mouse but­
ton. This allows you to manipulate the complete object. 

You can do three things to a selected MacPaint object in MacWrite. You 
can move it horizontally (from left to right) in order to center it or position 
it as you desire. You can add Return characters in front of the object in order 
to position it vertically. Or you can stretch and shrink the object. 

To center the letterhead on the page, move the cursor so it touches the far 
right or left border of the selected letterhead and hold down the mouse but­
ton. You can then drag the letterhead into the appropriate position. 

If you want to stretch or shrink the letterhead, move the cursor to one of 
the small squares along the bottom of the rectangle that surrounds the let­
terhead. Click the mouse button and hold it down while you drag the cursor 
around the screen. This technique changes the size of the letterhead, but be 
aware that it may distort your MacPaint object. 

Here is a portion of a letter in which the letterhead is part of the header. 
Notice from Figure 8-3 that the Date facility of the header was used to cause 
the current date to be printed out. 

Mr. John Smith 
Acme Computer Supplles 
111 North :Birch Avenue 
Cloudy Gulch, Montana 0000 1 

Dear John 

May 15, 1934 
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CREATING A FORM LETTER 

You can use the Clipboard to move the letterhead into a MacWrite form 

letter. To do this, Copy the letterhead onto the Clipboard and Paste the 
letterhead into a blank MacWrite document. Then go ahead and set up any 
margins, line spacings, and other settings that you will be using in the let­
ter. Save the Mac Write file on disk with a name such as "FORM LElTER," 
identifying it for future reference. 

When it comes time to write a letter, you just open up the FORM LET­
TER file and type in the text. This way you do not have to be concerned 
with the margins, spacing, and the letterhead each time you write a new 
letter. When you finish the letter, use the Save As command in the File menu 
to save the letter in a separate file. 



P A R T F I V E 

• 

The remaining chapters describe additional 
applications for MacPaint and MacWrite. The goal 

of these chapters is twofold. First, you will see by 
example how many of the commands discussed in earlier 

chapters actually work. Second, you will see new 
ways in which you can use the combined power of 

MacWrite and MacPaint to meet your particular needs. 
By the time you finish working through these chapters, 

you can put your creative ideas and your understanding of 
the Macintosh's capabilities to work on projects of your own. 



C H A P T E R N I N E 

WORKING 
WITH TEXT 

IN MACPAINT 

MacPaint offers a variety of text-oriented operations that allow you to enter 
and edit strings of text on the MacPaint window. You may edit to delete 
characters or change the font, style, or font size of the text. Text-oriented 
operations are accomplished with the text tool and the commands found 
within the Font, Fontsize, and Style menus. 

Comparing the text manipulation features of MacPaint with those of 
MacWrite may lead you to believe that there is little or no difference in how 
the two programs handle text. However, because of the fundamentally dif­
ferent goals of the two programs, MacPaint and MacWrite perform text 
operations in quite different ways. 

MacWrite, being a word processor, is geared toward text-editing tasks. 
When you create a memo or some other text document, MacWrite saves the 
contents of that document as a set of text characters, each character having 
its own character attribute (the font, font size, and style associated with that 
character). You can edit any portion of text within a document simply by 
selecting that text (as discussed in Chapter 3) and performing the appropri­
ate MacWrite operations. 

MacPaint, being a graphics processor, is geared toward efficient graphics 
design. When you use any MacPaint tool to place an image on the window, 

125 
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whether it is a filled-in oval, a figure drawn with the pencil tool, or even 
text typed in with the text tool, MacPaint treats the object only as an image. 

When you use the text tool to type in characters, MacPaint temporarily 
treats those characters as text, and you have the opportunity to edi t them. 
However, as soon as you perform a graphics-oriented command, MacPaint 
no longer considers the text as a string of characters, but rather as a group of 
graphics objects on the window. 

USING THE TEXT FEATURES 
OF MACPAINT 

Let's work through a simple example to demonstrate the use of MacPaint 
text operations. Start up MacPaint and select the text tool. Point the cursor 
to a position on the window where you would like to enter text. Click the 
mouse buuon to set the insertion point, which indicates where the text is to 
be placed (see Chapter 3 fo r more on the insertion point). Now type in some 
sample text. For example: 

0 untitled 

This is sample text. 

I 

You may now pull down the Font, FontSize, and Style menus to experi­
ment with the variety of character attributes available. If you choose the 18 
point London font and the underline style, the text will change as shown in 
the following illustration. 
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untitled 

I 

1!l:b.t.s t.s .sa:mylt ttxt.l 

The text-oriented commands (all of which are found in the Font, Font­
Size, and Style menus) were covered in Chapter 3 with the exception of three 
commands unique to MacPaint: the Align Left, Align Middle, and Align 
Right commands in the Style menu. The Align Left command, the default 
choice, sets the left margin of the text at the initial insertion point. Align 
Right sets the right margin of the text at the initial insertion point. Align 
Middle causes the text to be centered on the initial insertion point. If you 
pull down the Style menu and select the Align Middle command, the pre­
vious example will look like this: 

untitled 

1!l:b.t.s t.s .sa:mylt ttxt.l 

I 

Notice that each time you select a text-oriented command, every character 
that you entered is affected. You can even press the RETURN key, type in 
more text, and change the attributes for all the text at once. At this point, 
MacPaint recognizes the entire portion of text as a string of characters. 

Press the ENTER key and type in some more text. If you now change some 
of the character attributes, you will notice that the only characters affected 
are those you typed in after the ENTER key was pressed. The ENTER key is 
used to indicate that you are finished with the editing and attribute ch anges 
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to a portion of text. Using the previous example, press the ENTER key, select 
the Align Left command from the Style menu, and enter some more text. 
Now you can change the font and style attributes to obtain the following: 

untitled 

Pressing the ENTER key, repositioning the insertion point, or using any 
graphics-oriented command actually alters the way in which MacPaint 
views the characters you have entered. From that moment on, MacPaint sees 
the previously entered text characters only as graphics shapes. You will not 
be able to edit those characters with any of the text-oriented commands. 
Thus, you should be sure that you are done editing the text before you press 
the ENTER key or use any non-text MacPaint function. 

MANIPULATING TEXT 
AS GRAPHICS OBJECTS 

Since MacPaint normally views text characters as standard graphics objects, 
you are free to use any of the normal graphics tools like the lasso or the 
eraser to manipulate all or part of the text string. If text changes are 
required after you press ENTER, you will have to erase the text (using the 
eraser) and start over again. 

One tool that is particularly useful with text is the selection rectangle 
(discussed in Chapter 5). Recall that this tool allows you to select a rectangu­
lar area for a variety of operations, such as repositioning, deleting, or mak­
ing an exact copy and moving it somewhere (either to another part of the 
window, to the Clipboard, or even to the Scrapbook). 

Once you have selected an area of the MacPaint winqow with the selection 
rectangle, you also have the opportunity to stret~h or shrink all of the 
objects within that rectangular area in horizontal and vertical directions. To 
accomplish this, you move the cursor within the selected area until it 
becomes an arrow, hold down the COMMAND key while pressing the mouse 
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buuon, and drag the cursor left, right, up, down, or along a diagonal. You 
will see the shapes within the selected area stretch or shrink as appropriate. 

In the following example, the image has been selected with the selection 
rectangle: 

robot 

You can make the object wider and shorter by positioning the cursor arrow 
in the lower-right corner of the selected area, holding the COMMAND key 
down, and dragging the cursor to the right and slightly upward. Notice, 
however, that the image tends to distort somewhat. 

robot 

r-- ----- ----- - ----------------- -- -

----:~ 
· : · 
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PROJECT 

AN EXAMPLE: BANNER TEXT 

Let's combine the stretching capabilities of the selection rectangle with 
MacPaint's text manipulation features to create characters larger than the 
maximum 72 point size offered by the FontSize menu. 

Step 1: Clear the MacPaint screen. Select the text tool. Pull down the 
Font menu and select the Chicago fon_t. Pull down the FontSize 
menu and select 72 point. Pull down the Style menu and select 
the Align Middle, Bold, and Underline commands. 

Step 2: Place the cursor about a third of the way down and halfway across 
the MacPaint window, and click the mouse button to position 
the insertion point. Now type in BANNER. Press the RETURN 

key and type in TEXT. Your screen should look like this: 

sO untitled 

I 

BANNER 
TEHT 

Step 3: Choose the selection rectangle. Draw as small a selection rectan­
gle as possible to enclose the text completely. Reposition the 
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selected text in the upper-left corner of the window by pointing 
the cursor within the selected region, holding down the mouse 
button, and dragging the entire area into the corner. 

I 

________ IEH_I _____ ~ __ : 

You can now stretch the text to fill the screen completely. Move 
the cursor into the lower-right corner of the selected rectangle. 
Press and hold down the COMMAND key; then press and hold 
down the mouse button. Drag the cursor down to the lower-right 
corner of the window. This should stretch the text so it fills the 
screen: 
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Step 5: Pull down the Edi t menu and select the Trace Edges command. 
This tells MacPainL LO "ho llow" out all of the objects in the 

selected area. 

0 
0 

Step 6: Select the paint bucket from the tool paleue. To choose a differ­
ent pattern for each leuer, point the cursor at the desired pattern 
from the pauern palelle and click the mouse button; then paint 
the letter by moving the paint bucket cursor into the leuer and 
clicking the mouse buuon. T he fina l result looks like this: 

BR
.,,,,,,., ... , ..... 

l":T!':'' ,,l,,,:,,. 

:·'·:-*:·' :·'·:·'·:· 
:·'--:·'·:·' r'-:·:.,. 
,.: . .,.:..,.·. :·'-:·'·:· 
:-'-:·'·p: •• :.,.r ••• :.,. 

:-'--:·'·:-" :·=·:-'·:· 
:-'-:·'·:· .·'-:·:.,. 
;-!·:·'·:- ,•1·:·'·:· 
;"":.!":,.· :·'·:•:...:. Ell 

As you can see, MacPaint makes no distinction between text characters 
and other graphics objects. While this may seem restrictive, it actually gives 
you more freedom LO intermix graphics and text with all of MacPaint's 
graphics-oriented LOols. 



C H A P T E R T E N 

CREATING SCIENTIFIC 
AND MATHEMATICAL 

FORMULAS 

Formulas combine text and graphics to form a specialized language for 
communicating thoughts and ideas. In this chapter, you will look at some 
methods for creating formulas on the Macintosh. You will see that the 
unique features of the Macintosh allow you to depict formulas clearly and 
accurately-something not possible on most microcomputers. 

AN INTRODUCTION TO FORMULAS 

A formula is simply a collection of symbols that are joined in such a manner 
as to express a concept or thought concisely, providing a standardized 
method by which all members of a particular group can exactly understand 
a concept. Each branch of science and mathematics has its own special types 
of formulas, and oftentimes its own set of symbols. Even when symbols are 
shared among different fields, their meanings can differ. Figure 10-1 gives 
examples of formulas from different areas of science and mathematics. 

Notice the variety of symbols used in these formulas. Formulas may 
include alphanumeric characters, Greek characters, custom or special­
purpose symbols, and superscripted and subscripted variations of all of 

133 
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I dx 
(x+ 1) ./ ln(x+ 1) 

P40 10 + 6H20 ~4H2P04 
Phosphor"Us Phosphoric 

Oxide Acid 

L = Jb .J [ f'C t) l 2 + [ g ·c t) l 2 d t 
a 

ammonium 
cyanate 

where 

Figure 10-1. A sampling of formulas 

ur~a 

_s_!_ 
r!(s-r)! 
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these. In addition, character styles like boldface and italics, as well as differ­
ent character sizes, are used in formulas. 

Most microcomputer systems have a limited set of characters, sizes, and 
styles available for creating formulas. To avoid this limitation, the actual 
formula is often replaced with the best approximation possible using the 
available characters. This is true of even very simple formulas. For example: 

A.n~a of a cir-cle = TJr 2 

Votu.me of a spher-e = ~ TJr 3 

On many microcomputers, these formulas would be displayed as 

Votu.me of a spher-e= 4/3 *PI * R .. 3 

While the differences are not too radical in these examples, more complex 
formulas become almost indecipherable on most microcomputers. The 
Macintosh provides two methods of accurately representing formulas in 
documents: a quick method using MacWrite, which will usually give you 
acceptable though rough-quality results, and a more detailed approach 
using MacPaint, which yields formulas that are close to picture-perfect. 

ENTERING FORMULAS 
WITH MACWRITE 

The basic idea of the quick MacWrite approach is to use its wide selection of 
characters, fonts, styles, and sizes to make the best-looking formulas that you 
can. The Macintosh offers a number of special characters that are useful for 
writing formulas. In addition to the standard alphanumeric (A-Z, 0-9) and 
punctuation characters, the Macintosh offers the special characters shown in 
Figure 10-2. 

Looking at your Macintosh's keyboard, you may well wonder where these 
characters are. They are entered by holding down the OPTION key and then 
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i"IM f..¢oo § q • ~ g '¢ 
0 -+ 

reC£2:®'¥ " 0nn " ,, ' , << >> 
0 A. B a f @ ll ... re/£0 c; <; a I ~ 

~ 0 J ll ~ ~ + (., 
NOTE: Each of the characters below is entered 

via the SHIFT-OPTION-- keys from 
particular FONTs. 

Figure 10-2. Special character set 

pressing one or two other specified keys. The keyboard layout (for the 
United States version of the Macintosh) is shown in Figure 10-3. Figure 
I0-3a shows the normal charact~rs that are entered when a key is pressed. 
Figure l0-3b shows the unshifted and shifted characters entered when a key 
is pressed in conjunction with the OPTION key. Notice that not every key has 
an alternative character. 

NOTE: Certain font types and sizes available on the Macintosh will 
not display some of the special characters. See Appendix A for a listing 
of the different characters that can be used with each font and font size. 

There are no special tricks to entering formulas with MacWrite. All it 
takes is a little thought about the most suitable placement, style, and size of 
the characters to be used. Once a formula has been typed into a document, 
you can use the features of MacWrite to make changes. 
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Figure 10-Ja. Standard character k eys on Macilltosh keyboard (U.S. version) 
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Figure 10-Jb. Special character keys 
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Figure 10-4 shows MacWrite versions of the formulas shown earlier in 
Figure 10-1. Notice that the biggest problem with these formulas is the posi­
tioning of the characters. The reason is that MacWrite is primarily a word 
processor. While characters of all different sizes and typefaces can be mixed 
on the same line, MacWrite will automatically expand the height of the line 
to accommodate the largest character. Furthermore, the bottoms of all char­
acters on a line must align. This means you cannot place individual charac­
ters in any position you wish. Nevertheless, MacWrite can be used for many 
formulas and give quite acceptable results. 

PICTURE-PERFECT FORMULAS 

If you need to enter formulas accurately, you can take advantage of the 
graphics tools in MacPaint. The idea here is to use MacWrite as you type up 
reports or papers, but leave space for any formulas; then you can work with 
MacPaint to design the formulas and integrate them into your MacWrite 
documents. 

It is quite easy to use MacPaint to enter formulas, and after just a little 
practice, you can do it fairly quickly. Most important, though, the results 
will be excellent. For examples of formulas entered with MacPaint, look at 
Figure 10-l again-those formulas were all generated with MacPaint. 

Creating formulas with MacPaint is superior to creating them with Mac­
Write for two reasons. One, as you saw earlier, MacWrite is limited in its 
ability to position characters in the formula. For example, even though you 
can intermix both small and large characters on a MacWrite text line, you 
cannot freely position characters in the text line. 

This is done easily with MacPaint, however. MacPaint allows you to spec­
ify the position of any character or group of characters on a page, because it 
does not distinguish between text characters and graphics objects, as you saw 
in Chapter 9. 

MacPaint's second advantage is that it allows you to customize select por­
tions of the formula. If you need a special character that is not part of the 
Macintosh's character set, you are free to design it yourself with MacPaint. 
You can also modify and enhance an existing character to fit into your for­
mula. In the following example, you will use this capability to extend the 
bar of the square root character to form a more traditional square root sign. 
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J dx 

(x• 1 )J 1n(x• 1 ) 

n 4 3 2 

}: t • mn+IM6n +9n +n-U 
i=l 30 

Phosphorus 
OXIde 

Phosphoric 
Acid 

b 2 2 

L =I -/([f'(t)] +[g'(t)] ) dt 
a 

heat 

NH4CNO ---> C=O: 

ammonium 
cyanate 

(r )( b ) 

H2N 
urea 

!k.l(n-kl where (s) = s' 
(r+b) (r) r!(s-r)! 
( n ) 

Figure 10-4. Formulas created with MacWrite 
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PROJECT 

ENTERING FORMULAS 
WITH MACPAINT 

The procedure for entering formulas with MacPaint has two steps: (1) break 
the formula into segments and enter each segment on the MacPaint window, 
and (2) assemble the segments into the final formula. 

Step 1: First, separate the formula into groups of characters that are sim­
ilar in size and alignment. Enter each group into the MacPaint 
window in any position. This will give you an "exploded view" 
of the formula. Once the parts of the formula are entered, you can 
combine these groups into a single formula. 

As an example of this step, let's look at how you might divide the 
following formula: 

L = r ../ [f'Ct)F+[g'CUF dt 
a 

You can divide this formula into ll different segments, all of 
which you enter separately into the MacPaint window. The font, 
size, and style of each of these ll parts is specified in Figure 10-5. 

An important part of this step is to select appropriate character 
fonts, sizes, and styles for the components of the formula. For 
example, if a formula includes superscripted or subscripted sym­
bols, you will probably select a small character size for them, say 
9 or 12 point. You might then choose the Plain character· style 
since this is often more legible at small sizes than are the Bold or 
Italics styles. 

After selecting the font, size, and style for a component of the 
formula, select the text tool from the MacPaint tool palette. Move 
the cursor to an unused portion of the screen. Click the mouse 
button to position the insertion point and type in a component. 
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b 

I ..f 
L 

2 2 

a [ f'( t)] + [ g '( t)] 

Font, Size, and StY-le of Each Part: 

L New Vork, 24 pt, Bold 

New Vork, 18 pt, Bo I d 

I Geneva, 24 pt Bo I d 

..[ Geneva, 24 pt, Bo I d 

b Geneva, 12 pt. PI ai n a 

2 Geneva, 9 pt, PI ai n 
2 

dt Geneva, 18 pt, Plain 

[ f'( t)] + [ g '( t)] 

LINE Operation 

Geneva, 18 pt, PI ai n 

Figure 10-5. Parts of a formula 

dt 

Repeat this step until you have entered all the components of the 
formula in different areas of the screen. 

Step 2: This step is like assembling a simple puzzle. Using the lasso, all 
you need to do is to select and move the pieces around so they fit 
together to create the final picture. 
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Select the lasso from the tool paleue. Move the Jasso over to a 
part of the formula that you want to move. Pressing the mouse 
button, draw a loop around that part. Release the mouse button 
to cause the loop to tighten around the image. 

ell 
2 

a [ f"(t)] +[g"(l ) ] 

Having selected a component from your formu la, move the cur­
sor into the selected image until it changes into an arrow. Press 
the mouse button so you can drag the image around the screen. 
Move this image into p lace and release the mouse button. 

Rather than try to assemble the whole formula at once, you may 
want to build subassemblies from the individual components. In 
other words, if the formula consists of three or four natural sub­
units, assemble these first. Then you can easily join the sub­
assemblies together to form the final formula. T he example eas­
ily divides into three subassemblies: 

Sub-assemb ly • 2 

Sub- assembly •1 
dt 

I L = s: I 
Sub-assembly •3 

[ n uP + [ g ·cuP 
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After completing the construction of the subassemblies, you can 
use the lasso to merge these into the final formula. 

MOVING THE FORMULA 
INTO MACWRITE 

Once your formulas have been created with MacPaint, you will need to move 
them into a Mac Write document. If you have only one formula to move, you 
can use the Macintosh Clipboard to transport it into the MacWrite docu­
ment. This is a simple process. Using the selection rectangle in conjunction 
with the Edit menu's Cut command, move the completed formula into the 
Clipboard. Exit MacPaint. Open your MacWrite document and Paste the 
formula into the proper part of the document. 

If you have more than one formula, you will probably be better off if you 
save each one on a separate Hpage" of the Macintosh Scrapbook. You can 
then open your MacWrite document and transfer these formulas one at a 
time. The mechanics of moving items back and forth between MacWrite and 
MacPaint are explored more fully in Chapter 7. 

After creating a formula with MacPaint and moving it into a MacWrite 
document, you may discover that you need to change the formula. Mac­
Write, of course, does not allow direct editing of any item created by Mac­
Paint, even if that item consists only of text. In that event, you will have to 
move the item to be edited back into MacPaint, make the necessary changes, 
and then move it back again to the MacWrite document. 

A suggestion: When creating a document containing formulas, you might 
want to use MacWrite to enter the formulas quickly while typing in the 
document. This makes it easier for you to edit the formulas as changes are 
needed. When you are finished with all of the changes, you can use Mac­
Paint to create the final formulas and move them into the MacWrite 
document. 



C H A P T E R E L E V E N 

TEXT 
HIGHLIGHTING 
AND EMPHASIS 

An important goal in writing good reports (or memos or letters or even 
books) is to make them easy to read. There are few things as difficult to read 
as a long report filled with unbroken text, regardless· of the quality of writ­
ing. One technique often used in report writing is text highlighting, to 
emphasize the major ideas of a discussion. By applying several highlighting 
techniques, you can use MacWrite and MacPaint to produce visually excit­
ing and well-organized reports. 

You will look at two types of highlighting in this chapter. First, you see 
how to design headings that identify major sections of text. An example 
illustrates the design of an attractive chapter heading for use in a report or 
book. Second, you will work with various MacPaint tools to emphasize por­
tions of the text itself. This type of highlighting can help ensure that very 
important points are brought to the reader's attention. 

145 
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PROJECT 

CREATING 
CHAPTER HEADINGS 

Chapter 4 discussed the advantages of using level headings to identify the 
various divisions of a report. The design of the level headings presented in 
that chapter are adequate for most needs, but sometimes you might want to 
go still further and create some very distinctive headings to separate major 
divisions. For example, you might use MacPaint to design very eye-catching 
chapter headings. 

In much the same way that a letterhead was created in Chapter 8 using 
MacPaint and then transferred to a MacWrite document, you can use Mac­
Paint to design attractive chapter headings and then integrate them into a 
MacWrite document. 

There is really nothing special about the techniques used for creating 
chapter headings. In fact, you can take some of the designs used as letter­
heads and easily adapt them as chapter headings. Should you desire more 
practice in the combined process of using MacPaint and MacWrite, you may 
wish to take a few minutes to try the following example. 

Step 1: Start up MacPaint with a clear window and select the paint 
bucket from the tool palette. Choose the solid black pattern from 
the pattern palette. Move the cursor to the window and click the 
mouse button. After a moment, the entire window should turn 
solid black. 

Step 2: Select the filled box from the tool palette and choose the larger of 
the two grid patterns from the pattern palette. Pull down the 
Goodies menu and select the Grid command to turn on the grid 
feature (see Chapter 6 for more information on the Grid com­
mand). Move the cursor to the window and draw a filled box 
covering the entire screen except for a solid black border. 
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Step 3: Again select the black pauern from the pattern palette, and still 
using the filled box tool, draw a smaller solid box on the win­
dow, something like this: 
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Step 4: Select the solid white pauern from the pattern paleue. Still using 
the filled box tool, draw a white rectangle on the screen overlap­
ping the black rectangle. Notice the three-dimensional effect that 
results from this. 

r a File Edit Goodies Font FontSize Style 

This gives you the skeleton of a chapter heading. You should save 
a copy of this on disk so you can use it for each chapter of the 
report. To do this, pull down the File menu and select the Save 
As command, supplying an appropriate filename. 

Step 5: Select the text tool; then choose Athens from the Font menu, 18 
point from the FontSize menu, and Bold from the Style menu. 
Turn the grid off by pulling down the Edit menu and seiecting 
the Grid command again. 

Move the cursor into the upper-left corner of the white rectangle 
and click the mouse button. This sets the insertion point. Now, 
enter the chapter heading, for example, "CHAPTER THREE­
BUSINESS FORECASTING," pressing the RETURN key after 
each word. Your screen should look like the illustration on the 
following page. 
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CHRPTER 
THREE 
BUSinESS 
FORECRSTinG 

Step 6: Choose the selection rectangle from the tool palette. Move the 
cursor over to the window and draw a rectangle around the words 
"CH APTER THREE." Pull down the Edit menu and select the 
Trace Edges command, as shown here: 

:-ciiiiJiT'i:if -- -- j 

i_TJ!!l_~~- _______ ~ 
BUSinESS 
FORECASTinG 



150 I Using MacWrite and MacPaint 

This will "hollow out" any objects within the selected region, in 
this instance, the "CHAPTER THREE" heading. 

Step 7: Now select the paint bucket tool. Choose the light gray shading 
from the tool palette. Move the cursor to the white area of the 
chapter heading. 

Press the mouse button to paint the white area gray. You will 
need to paint the inside of any closed letters, for example, any 0 
or Q. The final chapter heading looks like this: 

Step 8: You need to store the chapter headings as you create them. The 
Scrapbook is probably the best place to store them. 

To move a chapter heading into the Scrapbook, select the entire 
MacPaint window by pointing the cursor at the selection rectan­
gle and double-clicking the mouse button. Pull down the Edit 
menu and select the Cut command to move the chapter heading 
onto the Clipboard. 

Step 9: Pull down the desk accessory menu (the apple icon) and select the 
Scrapbook accessory. Use the Paste command in the Edit menu to 
place the chapter heading into the Scrapbook. 
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For each chapter of the report, you can copy the heading skeleton saved on 
disk in step 4. Then add in the chapter number and title, and save the com­
pleted heading in the Scrapbook. When you are done, the Scrapbook should 
contain all of the chapter headings. At this point you can exit MacPaint, 
start up MacWrite with your report, and insert the chapter headings into the 
report. 

HIGHLIGHTING TEXT 

The idea behind text highlighting is to set off selected portions of a docu­
ment so they stand out. Creative use of highlighting not only helps make a 
report more readable but can also ensure that very important points will not 
be overlooked. If the most vital themes are summarized in small highlighted 
text areas scattered throughout a report, even a casual reader will be able to 
get the point. 

You can highlight words, phrases, or sections of text. If you just want to 
emphasize a particular word or phrase in the midst of a paragraph, using a 
different character style may suffice. For example, you can use some combi­
nation of boldface, italics, and underlining to get the desired result. If you 
want to set off a section of text, you can place it between two solid lines 
made with the underline character. 

A common and effective method of highlighting special text is to build a 
box around it. These boxes are called highlight boxes. Using MacWrite, you 
can build a crude highlight box with characters like the asterisk. However, if 
you want professional-looking highlight boxes, you will need to use the 
facilities of MacPaint. The advantage of using MacPaint is that you can 
design any kind of box that you want. The disadvantage is that you must use 
MacPaint to build the complete box-including the text to be set within 
it-and then move the results to your MacWrite document. If you later need 
to edit the text in the box, you will have to move the box back to MacPaint 
to make the changes. 

SIMPLE HIGHLIGHT BOXES 

Building highlight boxes in MacPaint is a breeze. The box and rounded box 
tools give you all that is needed to create a box of any size. The line width 
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palette gives you a selection of border sizes for these boxes. 
The best approach is to enter the text to be highlighted and then build an 

appropriate box around it. In fact, you can enter the text with Mac Write and 
use the Clipboard or Scrapbook to move the text into MacPaint. Then you 
can use MacPaint to create the highlight box. 

Figure 11-1 shows a variety of simple text boxes created with the box and 
rounded box tools. The first box, Figure li-la, is the traditional highlight 
box. This is often the most effective method of highlighting because of its 
simplicity. It catches the reader's attention without being a source of 
distraction. 

The box in Figure ll-lb was shaded with the paint bucket tool. Shading 
can sometimes be effective, but the result in this example is less than perfect. 
The shading only makes the text hard to read. 

If you wish, you can build a box with a border of a selected pattern. The 
boxes in Figures ll-lc and 11-ld take advantage of a special feature of the 
shape tools like box and rounded box that allows you to select custom 
borders. To draw a custom border, select an interesting pattern from the 
pattern palette and then choose a heavy line width from the line width 
palette; move the cursor onto the window, and hold down the OPTION key 
while you press the mouse button and draw the border. 

To create the box in Figure 11-le, first use the filled rounded box tool and 
the pattern of your choice to create the outer portion of the highlight box. 
In a separate part of the MacPaint window, use the plain rounded box tool 
to enclose the text (as in Figure Il-Ia). Next, select the lasso and draw a rope 
around the text box. Move the cursor within the selected box and press the 
mouse button. Now drag the text box into the larger filled box. Position it 
appropriately and release the mouse button. 

With the large selection of patterns to choose from and the ability to create 
your own patterns (using the Edit Pattern command in the Goodies menu), 
you can design many variations of highlight boxes. 

ICON BOXES 

The highlight boxes just discussed are easy to create, but they take little 
advantage of MacPaint's capabilities. You can use the extensive drawing fea­
tures of MacPaint to help you create icon boxes, special types of highlight 
boxes. An icon box is a text box with a special icon or picture that imme­
diately identifies the function of the box. The icon box can be used to attract 
a reader's attention. However, you should take care not to overuse it. 



a 

b 

c 

d 

e 
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Using just a simple box around ordinary 
text is really quite effective. Notice that 
this would stand out well in a report and 
is very legible. 

:···,···~~·~~,,~,,~·~'~'~'''~~·······~····: 
:This box takes advantage of the : 
• • :OPTION key to dra'! the border of the : 
:box in a selected pattern. : 
• • ····~········,~·,······,.,,., ........... ,,. 

,.,.,..,.,.,.,..,.,..,..,..,.,.,..,..,.,..fl'.,..~,..,..f/".,.,.,..,..,.,..,..,.,..,.,.,..,..,.,.,., ... 

~r~";~;~,;;,~;,d~;;;;;;~~t~;tt;;;~~;;;ri~~'~'~l~ 
!~ draw the border of the rounded box. ~~ 
;~i.ti:tl'ti:tl!l'fi!i.!!..*tl~l-:i.:~!..!!..-:::c:.-:t.fi:ti.(i:ti.!i.'Ci.!i:t:.~:.-::.~:.!!.!i:t!..!!.-:t-:::r:.-::.-::.-:::ci!~S· 

Figure 11-1. Highlight boxes 
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Figure 11-2 shows three different icon boxes: one to flag the reader's atten­
tion, one to caution the reader, and one to act as an alarm. There are many 
more forms that an icon box could take, each broadcasting a special type of 
message to the reader. 

The first two icon boxes in Figure 11-2 were drawn with the standard tools 
found in MacPaint. When creating icon boxes, concentrate on creating the 
icons first. Once you have made an icon that is acceptable, save it in the 
system Scrapbook for future use. You can then use the line tool to box in the 
icon and the text to be highlighted. 

FLAGII 
This box will contain things of 

interest. 

CAUTION II 
This box will contain very important 

warnings and notes of caution. 

ALARffill ~ 
~ This box can be used to 

emphasize vital information. 

Figure 11-2. leon boxes 
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CAPTURING MACINTOSH ICONS 

Let's look for a moment at the alarm box in Figure 11-2. It would not be too 
difficult to draw the alarm clock icon freehand, but there is an easier way­
by copying the alarm clock icon from the Macintosh alarm clock accessory. 
Following the steps described here, you can "capture," or copy, any Macin­
tosh icon for use in your MacPaint canvases. 

Pull down the desk accessory menu in the upper-left corner of the menu 
bar. Select the alarm clock accessory to display the time of day on your 
screen. Move the cursor to point to the "switch" on the right side of the box 
and click the mouse button. This should open up the clock window to show 
you the current date: 

0 6:03:16 PM r 
2/11/84 

At the bottom of the alarm clock window are three icons, a clock, a 
calendar, and an alarm clock. Selecting the clock icon will let you set the 
current time of day. Selecting the calendar icon allows you to view and 
change the date. The alarm clock icon allows you to set the alarm. It also 
lets you turn the alarm feature on or off. 

Notice that the alarm clock icon looks almost like the icon used in the 
alarm box of Figure 11-2. The only difference is that the alarm clock in the 
accessory is not "ringing." To add this detail, first click the mouse button 
with the cursor pointing to the alarm clock icon. Next, turn on the alarm by 
moving the cursor to the switch at the left end of the clock window. Finally, 
move the cursor to the calendar icon and click the mouse button. The screen 
should look like this: 

0 6:03:51 PM r 
2/11/84 
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The alarm clock icon is now ringing. The next step is to move the a larm 
icon into MacPaint so you can build the alarm box. 

The Macintosh has a special "snapshot" feature that you can use for 
doing this. If you ho ld down the SHIFT and COMMAND keys and press the 3 

key, the Macintosh will take a snapshot of the screen. That is, an exact 
image of the screen as you see it is placed into a file on the disk. The first 
snapshot you take will be given the name "SCREEN 0. " Successive snap­
shots will be called SCREEN 1, SCREEN 2, and so forth. The wonderful 
thing about this feature is that the Macintosh saves each snapshot in a Mac­
Paint file. This means you can use MacPaint to edit or print the contents of 
the snapshot. 

Going back to the example, take a snapshot of the entire screen, making 
sure to include the ala rm clock icon . Start up MacPaint. Select the Open 
command from the File menu and open the SCREEN 0 file. This will load 
the snapshot of the screen onto the MacPaint canvas. Looki ng at this wi th 
the Show Page command found in the Goodies menu, you see 

Use the grabber tool to move the snapshot around until you can see the 
alarm clock icon in the window. Then use the selection rectangle to draw a 
selection box around the alarm clock. Select the Copy com mand in the Edit 
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menu to place a copy of the alarm clock on the system Clipboard. Close 
SCREEN 0. 

Next, open a new file and select the Paste command from the Edit menu. 
Now you can position the alarm clock icon wherever you wish and finish 
designing the alarm box using MacPaint. 

This same approach can be used to make a copy of any icon used in 
MacPaint, MacWrite, or even the system desktop. Pressing the SHIFT, COM­

MAND, and 3 keys always saves a snapshot of the current screen in a 
MacPaint file. 



C H A P T E R TWELVE 

MACPAINT 
SHORT TAKES 

You do not have to be an artist in order to create exciting images with Mac­
Paint. But for those lucky few who do have an artistic bent, MacPaint offers 
unlimited opportunities for experimentation. 

This chapter offers ideas for exploring the creative possibilities of Mac­
Paint. In most cases, the examples provide more challenging applications of 
the features and functions introduced in earlier chapters. All of these tech­
niques are fun to try and can come in handy at the most unexpected times. 

FREEHAND DRAWING 

The two basic tools used in freehand design are the paint brush and the 
pencil. You can draw any imaginable shape with them- the only limita­
tions are your drawing talent and ability to use the mouse. 

Moving the cursor around the screen for pointing and selecting is easy 
with the mouse. The mouse also works quite well for drawing such things 
as lines, boxes, and ovals. However, drawing anything more complex 
requires practice and patience. 

Becoming adept at drawing with the mouse is the most difficult part of 
creating freehand drawings. But what MacPaint loses in ease of drawing 
with the mouse, it more than makes up for in its selection of tools. With its 

159 
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wide variety of brush shapes, the ability to undo (cancel) a previous opera­
tion, and the use of the Fatbits command, which allows you to make 
detailed changes to an image, you can readily experiment with a vast range 
of freehand drawing techniques. 

As you try to create more and more detailed and precise drawings with 
MacPaint, the difficulty factor increases, but fairly simple and straightfor­
ward pictures can be sketched by almost anyone. For example, Figure 12-1 
shows a section of body tissue. This modest but effective diagram could 
easily be included in a report written with MacWrite. 

BRUSH MIRRORS 

The Goodies menu contains a special command called Brush Mirrors. If you 
select this command a nd then use the paint brush tool on the MacPaint 
screen, you can obtain some interesting effects. Multiple copies of your 
brush strokes will appear as if they were being reflected in a mirror. 

Interstitial (between the cell) space 

Figure 12-1. Freehand sketch using MacPaint 
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When you select the Brush Mirrors command, the following window wi ll 
appear: 

OK None 

Each line of the square represents a mirror. You can select the horizontal, 
vertical, or either of the diagonal mirrors by clicking the mouse button on 
the appropriate line. Any or all of the four mirrors can be selected. Click the 
OK switch and select the paint brush from the tool palette to start your 
drawing. 

For example, if you select just the horizontal mirror line, MacPaint places 
an imaginary mirror a long the horizontal axis in the cen ter of the screen. As 
you paint a brush stroke o n the screen, the movement of the paint brush is 
mirrored to make a reflecting line: 
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The brush mirrors let you create symmetrical shapes, something not pos­
sible (or at least not easy) with freehand drawing. Notice one thing, though: 
the mirrors reflect the movement of the brush, not the lines drawn by the 
brush. 

The previous screen display was created wi th a round paint brush. Since 
the paint brush was symmetrical, the resulting drawing a lso was symmetri­
cal. The following example illustrates the. use of one of the angular paint­
brush shapes. If you look closely at the curves, you will notice that the shape 
they form is not truly symmetrical; only the path that the brush followed 
was perfectly reflected: 

.../········ 

-
This i s an image mirrored on the v ertical axis 

using the / brush shape. Notice that the images 
are not truly symmetrical; only the path o f the 

brush is symmetri cal. 

• 

, 
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PROJECT 

EDITING PATTERNS 

MacPaint offers a total of 38 standard patterns that you can choose from the 
pattern palette. However, you can replace any or all of these with patterns of 
your own design. To create a custom pattern, first pull down the Goodies 
menu and select the Edit Pattern command. This will allow you to edit the 
currently selected pattern. As a shortcut, you can point the cursor at any of 
the patterns in the palette and double-dick the mouse button to edit it. 

Creating your own pattern involves the same process as that of creating 
your own desk pattern in the desk accessory Control Panel (see Chapter 2 for 
more on this). Selecting the Edit Pattern command will result in the follow­
ing display: 

• ••••••• • ••••••• • • ••••••• 
·····~· ~:····· ••••• • • • • •••••• ••• • •••••• 

( OK ) ( Cancel ) 

The left-hand box shows the dot structure that makes up the currently 
selected pattern. This box is eight dots wide by eight dots high. Each of the 
dots can be independently turned on or off by pointing the cursor at it and 
clicking the mouse button. As mentioned in Chapter 3, this box can show 
over 18,000,000,000,000,000,000 different patterns, so you can really have 
some fun creating them. The right-hand box shows the changes you make to 
the pattern. 

Let's look at an example of setting up six custom patterns in the pattern 
palette. You can then use them as you would use any of the standard patterns. 

Step 1: Using the steps just discussed, replace six of the standard patterns 
(any six of your choice) with the custom designs shown on the 
following page. 
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OK 

1:L I 
( OK ) 

[] 
( OK ) 

Cancel 

1HHHH 
11111111 
11111111 
11111111 
IIIIIIII 

Ill II I II I 

( Cancel ) 

+++++++ TTTTTTT 
TTTTTTT 
TTTTTTT 
TTTTTTT 
·ltlfft+ 
( Cancel ) 

OK 

• I •• • • •• •• • 
OK 

••••• • • •• • • •••• 
OK 

Cancel 

Cancel 

II 
Cancel 

Step 2: Select Chicago from the Font menu, 72 point from the FontSize 
menu, and Outline and Bold from the Style menu. Use the text 
tool to type the word "PAINT" on the MacPaint window in out­
lined, or "hollow," letters. 

Step 3: Select the paint bucket tool; then select the appropriate custom 
patterns and paint each hollow letter on the screen. For example, 
select the "P" pattern, move the cursor inside the P of PAINT, 
and click the mouse. Repeat for the remaining letters in 
"PAINT." 

Step 4: Select the sixth custom pattern; then select the box tool from the 
tool palette. Using the heaviest line from the line width palette, 
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hold down the OPTION key and draw a rectangle around the word 
"PAINT." The OPTION key causes the selected pattern to be used 
as the border for the rectangle. Your screen should look like this: 

To save any custom patterns for future use, you can use the Save or Save 
As commands in the File menu. Then anytime you open this saved file, the 
custom patterns will be available in the pattern palette. 

REPETITIVE EDGE TRACING 

If you are looking for some interesting and unexpected (maybe even a little 
bizarre) special effects, you might experiment with the Trace Edges com­
mand in the Edit menu. This command was introduced in Chapter 9, where 
it was used to outline the edges of text characters. It also can be applied to 
any solid object on the MacPaint window. 

Let's try this now. Select the Brush Mirrors command from the Goodies 
menu and turn on a ll four mirrors as discussed in the previous section. 
Select the Brush Shapes command from the Goodies menu and select an 
interesting brush shape. Paint a design on the MacPaint screen; it doesn't 
need to be intricate or even pretty. 
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Point to the selection rectangle in the tool palette and double-click the 
mouse button. This will select the entire MacPaint window. Now select the 
Trace Edges command from the Edit menu to show the design in outline: 
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The result is not very interesting, but let's see what happens when you 
execute the Trace Edges command a number of times. (NOTE: You might 
want to use the shortcut for executing Trace Edges; that is, hold down the 
COMMAND key and press the E key on the keyboard. To repeat the command, 
hold down the COMMAND key and press the E key again.) 

r a File Edit Goodies Font FontSize Style 
., 

Notice that with each execution of the Trace Edges command, the last 
edge itself is traced. The newly formed edges radiate like ripples on a pond. 
As the ripples intersect, they form interference patterns. This technique is 
called repetitive edge tracing, and it can be used with any shape on the 
MacPaint window. 

You can use different patterns from the pattern palette and various brush 
shapes to get strikingly unique results. You can even limit the ripple effect 
to a small area of the display by selecting the area with the selection rectan­
gle, rather than selecting the entire screen. Figure 12-2 illustrates examples 
of repetitive edge tracing. 

SHADING 

The spray paint tool can be interesting but somewhat difficult to work with. 
You use it as you would a real can of spray paint. Once you select the spray 
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Note: 

This is a varwnt of the "tu.mb£in9 bwcks " pn.tchworR. 
pattern from Chapter 6. The patchworR. is fi.Ued 

with the pn.ttern A.FTER the ed!Je tmcin9. 

Figure 12-2. Patterns created with repetitive edge tracing 

paint tool from the tool paleue in MacPaint, you can make quick stroking 
motions with the mouse while holding the mouse buuon down to spray an 
object lightly, or you can make slow strokes and multiple passes to fill in an 
area completely. Since the Macintosh cannot display colors, MacPaint 
allows you to spray paint with different patterns. You can select any pattern 
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from the pattern pa leue (including a pattern of your own design) and spray 
in tha t pattern. 

One application of the spray paint tool is to use it to shade o bjects so they 
look three-dimensional. In the following example, a fl at circle was shaded to 

look like a sphere: 

Circle 

Three-dimensional shading is a difficult technique to master but can be 
fun to experiment with. 



C H A P T E R THIRTEEN 

PRINTING 
WITH 

THE MACINTOSH 

This chapter looks at the similarities and differences in pnnung with 
MacWrite and MacPaint. An understanding of how and why these programs 
print in slightly different ways may help you decide which method to use for 
printing. 

The primary printer for the Macintosh is the Apple Imagewriter. The 
information in this chapter deals specifically with the Imagewriter and may 
or may not apply to other printers. But regardless of the printer used, the 
mechanics of printing are greatly simplified with the Macintosh. You need 
to know absolutely nothing about the technical aspects of the printer in 
order to use all of its capabilities. 

PRINTING WITH MACWRITE 
AND MACPAINT 

You look in the File menu to find the printing operations for MacPaint, 
MacWrite, and most other Macintosh applications programs. The MacPaint 
File menu o££ers two printing selections, Print Draft, which gives you very 
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good quality printed output of the MacPaint document, and Print Final, 
which produces even better looking output than Print Draft. Once you select 
one of these printing commands, the current MacPaint graphics page will 
be printed out immediately. 

MacWrite offers two sets of printing options. The first is accessed by 
selecting the Page Setup command from the File menu. This gives you the 
following setup choices: 

Paper: ® US Letter 

0 US Legal 

Orientation: ®Tall 

0 A4 Letter 

0 International Fanfold 

0 Tall Adjusted 0 Wide 

OK 

(Cancel ) 

These options allow you to choose the type and size of paper on which 
your documents will be printed. Once you select settings, they will be used 
each time you print a document. 

You are offered a second set of options after you select the Print command 
from the File menu. At that time you will be presented with the following 
choices: · 

Quality: QHigh 0 Standard ®Draft OK 
Page Range: ®All 0 From: D To: D 
Copies: D 
Paper Feed: ® Continuous 0 Cut Sheet (Cancel ) 

These choices allow you to print a portion of a document and to select the 
quality of printing you want. (See Chapter 3 for more information on these 
options.) 

MacWrite gives you all of these choices while MacPaint gives you only 
two because of fundamental differences in the way the programs work. 

Recall from Chapter 7 that MacPaint looks at everything, including text 
characters, as graphics objects. When MacPaint prints a page, it simply 
prints out rows of dots in the same form as they appear on the screen. How­
ever, when MacWrite prints a document, it prints out the document as a 
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series of characters and as a result has control over the appearance of each 
character. 

The following four figures combine text and a MacPaint graphics image 
to illustrate the differences between the two printing methods. Figures 13-1, 
13-2, and 13-3 show the three qualities of printing in MacWrite. Note that 
the text within the graphics image was created with MacPaint and thus is 
not affected by the print quality of MacWrite. Notice also that the draft­
quality copy in Figure 13-3 does not include the MacPaint image and uses 
only one character font and size. The purpose of these restrictions is to give 
you the fastest printing speed. 

Figure 13-4 shows the example document printed out from MacPaint 
using the Print Draft command. The output from the Print Final command 
is not significantly better when using the Imagewriter printer and is not 
shown. The quality of text printed with MacPaint falls somewhere between 
standard- and high-quality printing with MacWrite. But the print quality of 
graphics objects in MacWrite is inferior to those same objects printed with 
MacPaint. The tradeoff is that some graphics quality will be sacrificed for 
superior text output or some text quality for superior graphics reproduction. 

This is a sample of the quality of printing done by 
macPaint and macWrit.e: 

ts lohlt loQoa toat 
9 Point Geneva Font 

12 Poiat New Yort Poat ill Bold 
12 Point Toronto Font in Bold Italics 

M DW.u81bdka ~boo lbQimd 

Let's also include a ffiacPaint graphics object here: 

Figure JJ-1. High-quality MacWrite printing 
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This is a sample of the quality of printing done by 
macPaint and mac Write: 

tS ~oint lon()'on 1ottt 
9 Point GE"neva Font 

12 Point New York Font in Bold 
12 Point Toronto Font in Bold Italics 

fi&1}~~~~ 

Let's also include a macPaint graphics object here: 

Figure JJ-2. Standard-quality Mac Write printing 

Th1s is a sample of the quality of printing done by 

MacPaint and H~cWrite: 

18 Point londor. Font 
9 Point Genna Font 

12 Point NfN York Font in Bold 
12 Point Toronto Font in Bold Italic• 

14 Point Venice Font Outlined 

let's also include a MacPamt graphics object here: 

Figure JJ-J. Draft-quality Mac Write printing 
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This is a sample of the quality of printing done by 
mac Paint and mac Write: 

t S :loittt l&on~on font 
9 Point G~n~va Font. 

12 Point New York Font in Bot<l 
12 Point Toronto Font in Bold .Italics 

n~~~~~ 

Let's also include a macPaint graphics object here: 

Figure 13·4. MacPaint print quality 

PRINTING WITH THE FINDER 

If you are using the Macintosh Finder (see Chapter 1), you can print any 
MacWrite document or MacPaint page simply by selecting it, pulling down 
the File menu, and selecting the Print command. The Finder will then start 
up the appropriate application and begin to print, giving you a choice of 
printing options if the document was created with MacWrite. When the 
printing is complete, you will return to the Finder. 

You can print more than one document at a time by selecting all of the 
documents you want to print and then selecting the Print {:ommand. To 
select more than one document, point the cursor to each document in suc­
cession and hold down the SHIFT key as you click the mouse button. If you 
print several MacWrite documents with this method, you must use the same 
settings for all of them. 
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THE PRINT SCREEN FUNCTION 

If you want a quick printed copy of the Macintosh screen, you can use the 
print screen function. This function can be used at any time (provided you 
are not printing something else) by holding down the SHIFT and CONTROL 

keys while you press the 4 key. This takes a snapshot of the screen and prints 
it out. 

An alternative approach is to hold down the SHIFT and CONTROL keys 
and press the 3 key. This will save a snapshot of the screen on disk as a 
MacPaint image. You can then use MacPaint to print this image. You can 
also use any of the MacPaint tools to manipulate the screen snapshot. For 
example, you can copy an icon for use with another MacPaint image. An 
example of this was discussed in Chapter 11. 



A P P E N D I X A 

THE KEYBOARD 
AND 

CHARACTER SET 

The Macintosh keyboard is made up of 58 keys: 10 control keys and 48 
character keys. The control keys are generally used for the specific purposes 
listed here; however, their uses may differ among applications programs. 
The I 0 control keys are: 

TAB Has the same function as the TAB key on a typewriter. Causes the 
cursor to jump to the next tab setting on the screen. 

CAPS LOCK Locks the letter keys into shifted position, but does not shift 
the numeric and punctuation keys. 

SHIFT (two of these) Enters the uppercase or shifted character for a given 
key. As on any typewriter, you hold down the SHIFT key and press the key. 
There is no difference between the left and right SHIFT keys. 

OPTION (two of these) Works in the same manner as the SHIFT keys. Can 
be used in conjunction with the SHIFT key and other keys to enter over 60 
special characters. (NOTE: These special characters are not shown on the 
keyboard. See the next section for more information on special characters.) 
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COMMAND (Cloverleaf) Used in conjunction with other keys to issue spe­
cial commands to an applications program. Each application specifies the 
use of the COMMAND key. This key is frequently used in shortcuts for 
commands that are normally accessed on pull-down menus. 

RETURN Tells an applications program to move the insertion point to 
the next line on the screen. 

ENTER Generally used to tell an applications program that you are fin­
ished with a certain part of a text entry. Acts like a special-function 
RETURN key. 

BACKSPACE Deletes the character to the left of the insertion point. If a 
section of text or some object is selected, BACKSPACE will erase the entire 
selected area. 

THE MACINTOSH CHARACTER SET 

The 48 standard character keys can be used in conjunction with the SHIFT 

and OPTION keys to enter a wide range of characters. There are four different 
ways of entering characters: the normal way (that is, using neither the SHIFT 

nor the OPTION key), using the SHIFT key, using the OPTION key, and using 
the SHIFT and OPTION keys (holding down both the SHIFT and OPTION keys 
while pressing a character key). The keyboard characters are shown in Fig­
ure 10-3. 

There are two special features to be noted in the figure. First, notice the 
key in the upper-lef~ corner of the keyboard (with the accent and tilde char­
acters). This key, when used with the SHIFT and OPTION keys, generates a 
number of special shapes depending on the character font and size you 
choose. 

For example, using this key with the New York font at 9 points generates 
a heart-shaped character, while the same key and font at 12 points gives you 
a picture of a small robot. If you select the Geneva font at 18 points and use 
the SHIFT and OPTION keys, you get a sheep character. All of the SHIFT­

OPTION characters for this key using each of the character sizes (9, 10, 12, 14, 
18, and 24 points) ahd the fonts are shown in Figure A-1. 

Second, notice the five keys in Figure 10-3b that show a shaded rectangle 
for the OPTION character. These keys generate special accent characters for use 



with international character sets: 

OPTION-"' 
OPTION-e 
OPTION-i 
OPTION-u 
OPTION-n 
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Grave accent 
Acute accent 
Circumflex 
Umlaut 
Tilde 

If you enter one of these characters with the OPTION key, nothing will 
appear on your screen. However, if you then press a vowel (a, e, i, o, or u), 
that vowel will appear with the appropriate accent above it as a single 
character.· 

Figures A-2 through A-12 list the full character set for each of the eleven 
fonts. These are arranged in columns that show the normal, SHIFT, OPTION, 

and SHIFT-OPTION characters for each key. The sequence of keys begins in 
the upper-left corner of the keyboard and continues from left to right. Notice 
that if a font does not support a given OPTION or SHIFT-OPTION character, 
the Macintosh displays a box for that character. 
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Cbit191: 

D 0 0 [] 0 D 
Gen~~~-

.... !) 

New York: 

• i • i 
Monaco: 

il I 
~; 

• 

lon~on: 

4 .! .e. JJ. 

Rthens: 
., ~ •.: ., 

Q • ., • ..,. ., 
·~ •.:. 

To[Qnto· 

" " • 
Ban IPPaooiSoo: 

Q l! 

Los tJ.ngeles: 

D 0 0 0 0 D 

Figure A-1. Characters for SHIFT OPTION (9, 10, 12, 14, 18, and 24 point) 
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we M6lD JJ®JNV= 

• \ I « » 
I D A 

0 A a a 
2 @ 

tN D s s 8 D 
3 # £ D d D D D 
4 $ ¢ 0 f F 0 0 
5 % D 0 g G @ 0 
6 § D h H D D 
7 & q 0 j J D D 
8 * • 0 k K D D 
9 ( I D I L D D 
0 ) 2 D D 

ce tE 
+ 0 0 z z 0 0 

q Q m <E X X 0 0 
w w D D c c c <; 
e E D v v 0 0 
r R ® 0 b B D 0 
t T D n N 0 
y y y 0 m M 0 0 
u u D < D D 
i I D > 0 0 
0 0 B e I ? 0 l 
p p 0 D 
I { •• 

) } 

FiguTe A-2. New York font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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IEIIIJEVIA lfMI; 

Q \ I « » 
1 0 a A a A. 
2 @ TM 0 5 s B 0 
3 # £, D d D a D 
4 $ ¢ D f F f D 
5 ~ 00 D g G ® 0 
6 § D h H D 0 
7 & q D j J ll 0 
8 * • 0 k K 0 0 
9 ( iJ 0 1 L , 0 
0 ) g 0 0 

a9 1£ 
= + - ± z z 0 0 
Q Q re a: X X ~ 0 
w w I D c c c; ~ 
e E 0 v v " 0 

r R ® 0 b B f 0 
t T D n N 0 
y v ¥ 0 m M J1 0 
u u 0 < ~ D 

I 0 > ~ 0 
0 0 " 0 I ? i 
p p TT n 
[ { 

,. , 

] } 

Figure A-J. Geneva font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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Figure A.-4. Toronto font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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lmiP JIQIPVa 

,., 
ll \ I « ) 

1 D a A 8 n 
2 @ - D 9 s B D 
3 • £ D d D D D 
4 $ t D f F D D 
5 • • D g G D D 
6 A. § D h H D D 
7 8 • D • J D [] J 
8 * • 0 k K 0 11 
9 ( g D I L D D 
0 ) g D D 

n 
G I 

= + 0 ± z 2 0 0 
q Q • I X )( D 0 

• u D 0 c c 9 c 
E 

, 
[] u [] e u • 

r R 0 D b B 11 D 
t T t [] H 

,., 
[] n 

y y ¥ D I n D D 
u u D I < ~ [] 
• I A. 0 > l D I 

0 8 I 1 + • 0 e l, 

p p 0 0 
[ { tl II 

] } 

Figure A-5. Monaco font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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'IIJDCifOOID [JQJ:JI Iii 

' ,., ' D \ I « » 
1 D 6 A A A 
2 @) TM D s s 0 0 
3 # £ 0 d 0 I 0 
4 $ t 0 f F f 0 
5 ~ 00 0 g G 0 0 
6 A § 0 h H 0 0 
7 & .. 0 j J ~ 0 
8 * • 0 k K 0 0 
g ( ! D I L .., 0 
0 ) ! 0 ... 0 

u • IE 
= + '* ± z z n 0 
q Q 0! (( H H ,:s 0 
w w I 0 t c ~ ~ 
e E 

, 
D u u ..{ 0 

r R ® 0 b B I D 
t T t D n N ,., 0 
y y ¥ D m M J1 0 
u u 0 < i D 

I A. 0 > l 0 
0 0 If • I 1 + l 
p p 1f II 
I { " " 
I } 

Figure A-6. Chicago font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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gaupooagnn 

• \ I « » 
0 

0 

t I I 0 Q. .t G .A. 
2 0 0 0 s s .B 0 
3 # 0 0 " D 0 0 
4 s 0 D f r 0 D 
5 • 0 D 9 G. 0 0 
6 "" 0 0 h. K 0 0 
1 • D D j 1 0 0 
a * D D ~ JC, 0 D 
g ( D 0 t L 0 0 
0 ) D 0 0 0 .. 0 D 

+ D 0 z z D D 
q Q D D X. X 0 D 
w w D D c c ~ ~ 
e E D " " 0 D 
r R. D D & I 0 D 
t T D D " N 0 
g y 0 0 m n 0 0 

" u 0 D < D 0 
i. 1. "" 0 ) D D 
0 0 • " I ? D l 
p p 0 D 
[ ( • " 
1 } 

Figure A-7. Venice font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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7lQlDlljiJD £liD'illl 

0 0 0 0 \ I 0 0 
1 ' D D I I 0 D 
2 (i) D D • i 0 D 
3 t1 D D ~ • 0 D 
4 • 0 0 ' , 0 D 
5 ~ D D ' • 0 0 
G 0 0 D ~ " 0 D 
1 lc D D j , 0 D 
8 • 0 0 k 1 0 D 
9 { D D 1 ]. D D 
0 J 0 D 0 0 

D D 
• + 0 0 ' J 0 0 
Q • 0 0 X .I 0 0 

• • 0 0 e ' 0 0 
e e D D b ' 0 D 
t • D D b I D D 
t 1t D D a • D 0 

' I D D 11l • D 0 
u II D D D D D 
t I D D D D D 
0 • D D I ? 0 D 
p ' D D 
r { " 

,. 

J } 

Figure A-8. London font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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rmn:plltl@l •Y= 

4 \ I < :. • 
1 [] a 8 ' A 
2 @) nt [] I s 8 [] 

3 • f. [] d D [] [) 

1 ' c [) f F [] [) 

5 " [] [] g G 0 [] 

6 [) [) b B [] [) 

7 & [) [] j J [] [] 

8 • • 0 k K [] [) 

g ( • [] 1 L [) [) 

0 ) I [] [] 

•• • IE 
= + [) [] z z [] [] 

q 0 II IE z I [] [) 

DJ w [] [] c c t; ~ 
a E [) • v D <> 
r B I) [) b B D [) 

t T [] D n [) 

g y y [] m m D [] 

u u [) ( [] [] 

i I [) ) [] [) 

0 0 • I I ? [] L 
p p [) [] 

[ ( " It 

] I 

Figure A-9. Athens font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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MrrlnliiJChiD!!IJIW: 

0 .. \ I 0 0 
1 I 0 D a A 0 D 
8 @ D 0 I 8 0 D 
I # D D d I) 0 D 
4 • D 0 f , D D 
5 X D D u G 0 D 
6 D D D h H D D 
7 & D D J J D D 
8 • D 0 k K 0 D 
9 ( 0 0 I L 0 D 
0 ) D 0 0 D 

D 0 
= + D D z z 0 0 
q Q D D X X 0 0 
m w 0 0 0 c 0 0 
8 E D 0 y v 0 0 

• R 0 0 b B 0 0 
t 'I 0 D n N D 0 
J y D D • M 0 0 
0 u 0 0 ( 0 0 
I I 0 0 > D 0 
0 0 0 0 I ? 0 D 
p p 0 D 
[ { ,, ,, 
] ) 

Figure A-10. San Francisco font character set (normal, SHIFT, OPTION, 

SHIFT-OPTION) 
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YIM ... •D= 

0 \ I 0 0 
I I i 0 a A d A 
2 @ 0 0 s s 0 0 
J # 0 0 d D 0 0 
4 s ¢ 0 f f 0 0 
s i 0 0 g G 0 0 
b 0 D n H 0 0 
7 &. 0 0 J 3 0 0 
8 * • 0 k K 0 D 
9 ( D 0 I L 0 0 
0 ) 0 0 0 , 

0 0 
= + 0 0 2 z 0 0 
q Q D D )( X 0 D 
w w 0 0 c c c c 
e f. 

, 
0 v 0 0 v 

r R 0 0 b 8 0 0 
t 1 0 0 n N 0 
y y 0 0 m M 0 D 
u u 0 J 

( D D 
i I 0 > 0 0 
() 0 (6 0 I ? D l 
p p 0 0 
{ { II ,, 
J J 

Figu.Te A-11. Los Angeles font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 
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lj4\UJru!l Jlll!JIU][; 

<!) "Co <!) 0 .. f 0 0 
f .9 D D p J ~ 

a (1: D D .w.,. 8 D D 

' t D D ... ~ 0 D 
& l D 0 t ...... o 0 
~. D D a [Jllllll0 D 

~ ' D D Q .JiiL D D 
~ ~ D D If ti.D D 
l:i r D D r * D D 

• • D D 0 • D D 
b ~ D D [ ~ D D .. ILo D D ' 

.c 0 D "' • t 0 D ~~ D 0 .. I D D ·I" D 
D 

• m9 D 0 ?; ~ D 
._.. Jffi.fu 0 0 Q ~ D D 
+ i D D 6a ~ 0 0 
l II 0 0 \l •• ~ 0 
8 ~ 0 D 0 •• D D 
~~ ~ 0 D I ~ 0 0 
l = ' 0 - ~ 0 0 
~ ~ 0 ' 9 0 0 
~t 0 0 

• ll D D 
~~o D 

FiguTe .4-12. Cairo font character set (normal, SHIFT, OPTION, SHIFT-OPTION) 



A P P E N D I X B 

FONTS, SIZES-, 
AND STYLES 

The Apple Macintosh provides a wide selection of character fonts, sizes, 
and styles available to MacWrite, MacPaint, and many other applications 
programs. The actual fonts, sizes, and styles may vary from application to 

application. Figure B-1 demonstrates some of the character choices that you 
might see. By mixing and matching the various character styles with the 
different fonts and sizes, you have several thousand types of characters to 
work with. 

Character fonts are stored on the System Disk and can be used by any 
applications program. These fonts require a considerable amount of disk 
space. In fact, over a quarter of your disk may be occupied by the fonts. 

You can free up a lot of this disk space if you find that you rarely or never 
use some of the fonts. The Font Mover program that comes with your 
Macintosh System Disk can be used to transfer selected fonts from the Sys­
tem Disk to a document file on a backup disk. Later, if you find that you 
want to restore one or more of these fonts, you can again use Font Mover to 
perform that task. 

The Font Mover program instructs you on how to move fonts into and 
out of the system. If you find certain fonts mentioned in this book that are 
not available in your applications programs, you should check your original 
System Disk for a file called Fonts. You can run Font Mover to check which 
fonts are stored in the Fonts file. 
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Character Fonts: 
Chicago font 

Geneva Font 
New York Font 

ftonaco Font 
Vmt.c;efont 

loUoatoat 
Rthans FODl 

Toronto Font 
Ban lPraooiloo lPon t 

Los Angeles font 
't;r+~Q~(t0 (C81ro Font) 

Text stgles· 
Plain Text 

Bold 
Italic 

Underline 
OUtline 
lhadoW 

Superscripting 
Subscripting 

Character Sizes· 

9Pviat 
10 Point 
12 Point 

14Point 

18 Point 
24 Point 

Figure B-1. Character fonts, styles, and sizes in MacWrite 



'""'m!M 
CtdalpFul 
GentM Font 
NewYortFact 

B(I!Ngjk 
tlllngoFant 
9eneYoFont 
New Yort Font 

U I """ml,; 

nonaco Font 
~ 
latnfnt 

1&.18FIIlt 

Toronto Font 

Foms, Sizes, and Styles I 195 

Ban iJPbdoo 11onl 
Los~l~ford 

Chleegcrfont nonaco Font !lhaa1 Fmt Blln l'nn•llllo l'on t 
Geneva Font 1IBnl.oo FDM Toront.o Font Los Angeles Font 

New York Font '"'= :teat 

Of ""IIR; 
Chicago Font 
Geneva Font 
New York Font 
ftonaco Font 
Vmi.c:e Font 

q. "'""* 
Chicago Font 
Geneva Font 
New York Font 
Monaco Font 
~.'mice font 

Chicago Font 
Geneva Font 

~tftt 
BthasFcmt 
Toronto Font 
Ban "•anulloo!Fon t 
Los Anqetesfont 

JAQou lout 
Bthans Font 
Toronto Font 
Ban !Fraooiloo IF on t 
Los An9eles font 

lo®oufout 
RthansFant 

New York Font Toronto Font 
Monaco Font 
Venice Font 

Ban !Praooiloo IPon t 
Los Angeles font 

Figure B-2. Suggested fonts and sizes in MacWrite and MacPaint 
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When you are using different character types in an applications program, 
you may notice that certain combinations of character sizes and fonts look 
better than others. Both MacPaint and MacWrite "suggest" the best size or 
sizes for a selected font by outlining them in the menu of character sizes. For 
example, if you are in MacPaint and select the London font, when you pull 
down the FontSize menu you will see the 18 point size outlined, telling you 
that this is the best size for London characters. 

Toronto 
San Francisco 
Los Angeles 
Cairo 
Chicago 
Geneua 
New York 
Monaco 
Uenice 

..~'London 

Athens 

9 point 
10 
12 
14 

v'flffi 
24 
36 
48 
72 

This does not mean that you cannot or even should not use character sizes 
other than the recommended ones. It is just that the suggested sizes are the 
best choices under most circumstances. Figure B-2 shows the range of char­
acter fonts and sizes (shown only in the Plain style) that are available with 
both MacWrite and MacPaint. 



A 
Aligning text, 40, 42 
Alphanumeric characters, 135 
Auto-repeat, 26 

B 
Banner text, 130-32 
Box tool. See Shape tools 
Brush Mirrors command, 78, 160-62 
Brush Shape command, 78 
By Date command, 14 
By Icon command, 14 
By Kind command, 14 
By Name command, 14 
By Size command, 14 

c 
Calculator, 22-23 
Change command, 46 
Character set, 178-91 

displaying, 23-24 
special, 136 

Clean Up command, 14 
Clear command 

in the Finder, 14 
in MacPaim, 74 

CLEAR key, 82 
Clipboard, the, 18, 103·05 

commands used with, 13-14 
using to create form letters, 122 
vs. the Scrapbook, 107-08 

INDEX 

Clock 
Alarm, 19·21 
internal, 26 

Close All command, 13 
Close box, 8, 15 
Close command 

in the Finder, 13 
in MacPaint, 73 
in MacWrite, 43 

Command blinking control, 26 
COMMAND key, 16, 80-82, 178 
CONSTRAIN key, 82 
Constrained tools, 85 
Control Panel, 25-28 
Copy command 

in the Finder, 13 
in MacPaint, 74 
in MacWrite, 45 
use with the Clipboard, 18, 104-05 
use with the Scrapbook, 18, 107 

COPY key, 82 
Cursor, 5 
Cut command 

D 

in the Finder, 13 
in MacPaim, 74 
in MacWrite, 45 
use with the Clipboard, 18, 104-05 
use with the Scrapbook, 18, 107 

Dates 
control for setting, 26 
displaying, 20 
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Decimal tabs, 39-41 
Desk Accessories, 17-29 

Alarm Clock, 19-21 
Calculator, 22-23 
Control Panel, 25-28 
Key Caps, 23-25 
Note Pad, 21-22 
Puzzle, 28-29 
Scrapbook, 18-19 

Desktop, the, 5 
Desktop pattern control, 27 
Dialog box, 15 
Directory windows, 6-10 

commands to change display of, 14 
Disk drive, 3-4 
Disks 

commands used to organize, 14-15 
Display Footers/Remove Footers command, 

46 
Display Headers/Remove Headers com­

mand, 46 
Display screen, 3-4 

copying contents onto disk, 156-57 
in MacPaint, 67, 69 
printing copy of contents, 176 

Double-click speed control, 27 
Drawing, freehand, 159-60 
Duplicate command, 12 

E 
Edit menu 

in the Finder, 13-14 
in MacPaint, 74 
in MacWrite, 45 

Edit Pattern command, 77-78, 163-65 
Editing text 

in MacPaint, 126-28 
in MacWrite, 35-36 

Eject command, 13 
Empty Trash command, 14 
ENTER key, 15, 127·28, 178 
Erase Disk command, 15 
Eraser tool. 71 

F 
Fatbits command, 76 

using to design patchworks, 93-94 
File menu 

in the Finder, 11-13 
in MacPaint, 72-73 
in MacWrite, 43-45 

Fill command, 74 
Filled shape tools, 71-72 
Find command, 45-46 

Finder, the, 6 
menu bar of, 10-15 
printing with, 175 
shortcuts with, 15-16 

Flip Horizontal command, 74 
Flip Vertical command, 75 
Folders, 6 
Font menu 

in MacPaint, 78-79, 126-27 
in MacWrite, 47 

Fonts, 47, 48 
character sets for all, 181-91 
display of all, 79 
emphasizing text with different, 59 
suggested sizes for difrerent, 195 

FontSize menu, MacPaint, 80, 126-27 
Footers, 47-50 

commands used with, 46 
use in reports, 62-64 

Form letters, 122 
Format menu, MacWrite, 46-47 
Formulas, 133-44 

creating with MacPaint, 139-44 
creating with MacWrite, 135-39 
defined, 133-34 
moving into MacWrite, 144 

G 
Get Info command, 12 
Goodies menu, MacPaint, 75-78 
Grabber tool, 70 
Graphics objects 

integrating into text files. 120-21 
manipulating text as, 128-29 
selecting. 104 
shading, 167-69 

Grid command, 76. 85-89 
using to design patchworks, 89-93 

H 
Headers, 47-50 

commands used with, 46 
use with letterheads, 120-21 
use in reports, 62-64 

Headings 
creating chapter, 146-51 
designing different level, 53, 55 
inserting in text, 54, 56-59 

Hexagons 
designing, 95-97 
drawing patchworks with, 98-100 

Highlight box, 61-62, 151-54 
Highlighting text, 59-62, 151-54 



I 
Icon boxes, 152-54 
Icons, 5 

copying Macintosh, 155-57 
Insert Page Break command, 47 
Insert Ruler command, 46 
Insertion poim, 13, 33 
Insertion poim blinking rate control, 27 
Introduction command, 78 
Invert command, 74 

K 
Keyboard, 3-4 

illustration of, 137 
Keyboard touch control, 27 
Keys 

L 

control, 177-78 
special, 138 
standard, 137 

Lasso tool, 68-69 
Letterheads 

creating, ll3-19 
integrating into text files, 120-21 
using to create form )etters, 122 

Line spacing, 40 
Line tool, 71 
Line width palette, 67, 72 

M 
Margins, 37-39 
Menu bar, the Finder, 10-15 

Edit menu in, 13-14 
File menu in, ll-13 
Special menu in, 14-15 
View menu in, 14 

Menu bar, MacPaint, 72-80 
Edit menu in, 74-75 
File menu in, 72-73 
Fom menu in, 78-79 
FontSize menu in, 80 
Goodies menu in, 75-78 
Style menu in, 80 

Menu bar, MacWrite, 40-47 
Edit menu in, 45 
File menu in, 43-45 
Fom menu in, 47 
Format menu in, 46-47 
Search menu in, 45-46 
Style menu in, 47 

Menus, pull-down, 5 
Mouse, 3-4 

clicking, 5 

Mouse, continued 
double-clicking, 5, 15, 82 
dragging, 5 
drawing, 159-60 
shift-clicking, 15 

Mouse tracking control, 26 

N 
New command 

in MacPaint, 73 
in MacWrite, 43 

Note Pad, 21-22 

0 
Open command 

in the Finder, 12 
in MacPaint, 73 
in MacWrite, 43 

Open Footer command, 46 
Open Header command, 46 
OPTION key, 24, 80, 177 

Index I 199 

Special characters accessible with, 
135-36 

Oval tool. See Shape tools 

p 

Page Setup command, 43-44, 172 
Paint brush tool, 70 

using for freehand drawing, 159-62 
Paint bucket tool, 70 
Palettes, 67-72 

line width, 67, 72 
pattern, 67, 69 
tool, 67, 68-72 

Paragraphs, 36-37 
Paste command 

in the Finder, 13 
in MacPaint, 74 
in MacWrite, 45 
use with the Clipboard, 18, 105 
use with the Scrapbook, 18, 106-07 

Patchworks 
designing, 89-93 
with hexagonal motifs, 93-l 00 
tools used to create, 83-85 

Pattern paleue, 67, 69 
Patterns 

creating custom, 163-65 
Pencil tool, 70 

using for freehand drawing, 159-62 
Poin'ter. See Cursor 
Prim Catalog command, 73 
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Print command 
in the Finder, 13, 175 
in Mac Write, 44, 172-74 

Print Draft command, 73, 171-73 
Print Final command, 73, 172-73 
Printer, 3-4 

Apple Imagewriter, 171 
Put Back command, 12 
Puzzle, 28-29 

Q 
Quit command 

R 

in MacPaint, 73 
in MacWrite, 45 

Repeating keys rate control, 26 
Reports, 51-64 

designing headings for, 53, 55, 146-51 
guidelines for writing, 51-52 
headers and fomers in, 63-64 
highlighting text in, 59-62, 151-54 
setting up using rulers. 54, 56-57 

Revert command, 73 
Rotate command, 75 

using to design patchworks, 92-93 
Rulers, 37-40 

s 

commands used with, 46 
copying, 57-58 
creating a report using, 54, 56-57 

Save As command 
in MacPaint, 73 
in MacWrite, 43 

Save command 
in MacPaint, 73 
in MacWrite, 43 

Scrapbook, the, 18-19, 106-07 
vs. the Clipboard, 107-08 

Scroll bar, 9- 10, 35 
Search menu, MacWrite, 45-46 
Select All command, 14 
Selecting 

graphics objects, 104 
text, 36 

Selection rectangle tool, 69-70, 128-29 
Set Page # command, 46 
Set Startup command, 15 
Shape tools, 71-72 

Short Cuts command, 78 
Shortcuts 

for the Finder, 15-16 
for MacPaint, 80-82 

Show Clipboard command 
in the Finder, 14 
in MacWrite, 45 

Show Page command, 77 
Show Rulers/Hide Rulers command, 46 
Size marker, 10 
Sizes, character, 80, 193-95 
Speaker volume control, 26 
Special menu, the Finder, 14-15 
Spray paint tool, 70. 167-69 
STRETCH key, 82 
Style menu 

in MacPaint, 80, 126-27 
in MacWrite, 47 

Styles, text, 17, 49, 80 
display of all, 194 
emphasizing with, 59-62 

T 
Tabs, 39-40 
Text 

aligning, 40, 42 
creating banner, 130-32 
editing. 35-36 
highlighting, 59-62, 151-54 
selecting, 36 
transferring between programs, 108-09 
using with MacPaint, 126-32 

Text tool, 70, 126-28 
Time control, 26 
Title bar. 8, 34 
Title Page command, 17 
Title pages, 47 

use in reports, 63-64 
Tool palette, 67, 68-72 
Trace Edges command, 74, 132, 165-67 

u 
Undo command 

in the Finder, 13 
in MacPaint, 74 
in MacWrite, 45 

UNDO key, 82 

v 
View menu, the Finder, 14 
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and its MacWrite"' and MacPaint"' software both fun and profitable. Along with 
many applications and ideas, you'll get the vital information on MacWrite and 
MacPaint -as separate programs and as a powerful combination. 

So much more than a how-to guide, Using MacWrite"' and MacPaint"' is a unique 
ideas book. The author shares with you imaginative ways of integrating MacWrite 
word processing with MacPaint graphics. 

Take the techniques presented in Using MacWrite"' and Mac Paint~ add a dash of 
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